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fonctionnalités de votre 
nouveau lecteur MP3
Elégant, intelligent, fi able et très pratique : votre nouveau lecteur MP3 est tout 
cela à la fois et plus encore ! Sa technologie de pointe offre une qualité de 
son et d’image exceptionnelle. Vous ne pourrez plus vous en passer, que ce 
soit pour pratiquer une activité physique, télécharger vos chansons préférées, 
regarder des vidéos ou même écouter la radio. Utilisez-le ne serait-ce qu’une 
seule fois et vous vous demanderez comment vous avez pu vivre sans !
TOTALEMENT MULTIMEDIA
Nous l’appelons “lecteur MP3”, mais il s’agit 
de bien plus que cela. Ce baladeur numérique 
est en effet capable de lire aussi bien de la 
musique que des vidéos, des images, du 
texte, ou bien même d’écouter la radio! La 
compatibilité Bluetooth permet quant à elle de 
connecter des casques stéréo sans fi l Bluetooth 
pour écouter vos chansons en toute liberté.

ÉCRAN TACTILE
Votre lecteur MP3 dispose d’un écran tactile 
réactif, qui répond de manière tactile à votre 
toucher. Vous pouvez faire l’expérience de 
divers effets de vibration.

CARTE MÉMOIRE EXTERNE
Votre lecteur MP3 dispose d’un logement 
pour mémoire intégrée compatible avec les 
cartes microSDTM et microSDHCTM, qui sont 
principalement utilisées pour sauvegarder ou 
transférer les fi chiers et les données.

RACOURCIS DYNAMIQUES
Placez l’horloge, le calendrier et autres 
widgets sur l’écran de votre menu principal à 
votre convenance, pour y accéder de manière 
directe et aisée.
Vous pouvez changer et décorer les boutons 
et les icônes en arrière-plan.

UNE QUALITE D’ECOUTE EXCEPTIONNELLE
Votre nouveau lecteur MP3 intègre la 
technologie sonore exclusive DNSe™ (Digital 
Natural Sound engine) de Samsung, fonction
permettant de fournir un son d’une pureté 
et d’une richesse incroyables pour un plaisir 
d’écoute inégalé.



consignes de sécurité
Signifi cation des icônes et symboles utilisés dans ce 
manuel d’utilisation :

AVERTISSEMENT
Indique un risque de blessure grave, voire mortelle.

ATTENTION
Indique un risque potentiel de blessure ou de dégât matériel.

ATTENTION

Pour diminuer les risques d’incendie, d’explosion, de décharge 
électrique ou de blessure lorsque vous utilisez le lecteur MP3, 
respectez les consignes de sécurité suivantes :

REMARQUE

Indique des conseils ou des pages auxquelles se référer afi n 
d’en savoir plus sur le fonctionnement du lecteur.

NE PAS tenter d’effectuer quoi que ce soit.

NE PAS démonter.

NE PAS toucher.

Respecter scrupuleusement les consignes.

Débrancher la fi che de la prise murale.

Appeler le service d’assistance technique pour obtenir de l’aide.

Ces symboles d’avertissement vous indiquent comment éviter de vous blesser 
et de blesser d’autres personnes. 
Veuillez respecter scrupuleusement les consignes. 
Après avoir lu ce chapitre, rangez ce mode d’emploi dans un endroit sûr afi n de 
pouvoir vous y référer ultérieurement.



consignes de sécurité
Ce manuel vous indique comment utiliser correctement votre nouveau lecteur 
MP3. Lisez-le attentivement avant toute utilisation afi n d’éviter d’endommager 
votre lecteur ou de vous blesser.
Portez particulièrement attention aux avertissements suivants :

PROTEGEZ-VOUS
Ne prenez pas l’initiative de démonter, réparer ou modifi er cet appareil vous-
même.
Evitez de mouiller l’appareil ou de le faire tomber dans l’eau. Si une telle situation 
se produit malgré tout, n’allumez pas le lecteur car vous risqueriez de vous 
électrocuter. Contactez plutôt le service clientèle de Samsung le plus proche de 
chez vous.
N’utilisez pas ce produit en cas d’orage et de foudre. Vous vous exposeriez à un 
risque de dysfonctionnement ou de décharge électrique.
N'utilisez pas les écouteurs lorsque vous conduisez une bicyclette, une 
automobile ou une moto.
Dans le cas contraire, vous risqueriez de provoquer un accident grave.
L’utilisation des écouteurs en marchant ou lorsque vous courrez, en particulier sur 
les passages piétons, peut se révéler très dangereuse.
Pour votre sécurité, veillez à ne pas laisser le câble des écouteurs gêner vos 
mouvements de bras ou d’autres objets avoisinants.
Ne conservez pas l’appareil dans un endroit humide, poussiéreux ou couvert de 
suie ; vous risqueriez de provoquer un incendie ou une décharge électrique.
N’utilisez pas le produit si l’écran est fêlé ou cassé. Vous risquez de vous blesser 
les mains ou le visage en manipulant des composants en verre ou en acrylique 
cassés. Dans ce cas, il est nécessaire de porter le produit à un centre de 
services Samsung afi n de faire remplacer l’écran. Les dommages causés par une 
manipulation inconsidérée du produit annulent la garantie.

ATTENTION

AVERTISSEMENT

ATTENTION



PROTEGEZ-VOUS
L’utilisation prolongée des écouteurs ou du casque peut fortement réduire votre 
acuité auditive.
Si vous vous exposez à un volume sonore supérieur à 85 dB pendant une durée prolongée, 
votre ouïe sera irrémédiablement endommagée. Plus le son est élevé, plus votre acuité 
auditive diminue (le niveau sonore d’une conversation ordinaire est compris entre 50 et 60 dB 
alors que celui provenant d’une route est d’environ 80 dB). 
Il est fortement recommandé d’utiliser un volume sonore moyen (le volume moyen est 
habituellement inférieur de 2/3 au volume maximal).
Si vous ressentez des bourdonnements dans les oreilles, réduisez le volume ou 
n’utilisez plus les écouteurs ou le casque.
La batterie ne doit pas être exposée aux sources de chaleur, comme par exemple 
les rayons du soleil ou les fl ammes.

PROTEGEZ VOTRE LECTEUR MP3
Ne laissez pas l’appareil dans un lieu où la température excède 35°C (ex. : sauna 
ou voiture en stationnement).
Evitez tout choc brutal (ex. : chute).
Ne posez pas d’objets lourds sur l’appareil.
Empêchez que des particules externes ou de la poussière ne pénètrent dans l’appareil.
Ne posez jamais l’appareil à proximité d’objets émettant des ondes 
électromagnétiques.
Veillez à toujours enregistrer vos données les plus importantes. Samsung ne 
saurait être tenu pour responsable en cas de pertes de données.
Utilisez uniquement les accessoires fournis ou agréés par Samsung.
Evitez toute projection d’eau sur l’appareil. Ne nettoyez jamais l’appareil à l’aide 
de produits chimiques (ex. : benzène ou diluant) ; vous risqueriez de provoquer 
un incendie ou une décharge électrique ou d’en détériorer la surface.
Suivez attentivement ces instructions afi n d’éviter de vous blesser ou 
d’endommager le lecteur.
Nous vous conseillons d’imprimer ce mode d’emploi en couleur et de paramétrer 
l’option d’impression « Ajuster à la taille de la page » pour qu’il soit plus agréable à lire.

ATTENTION

REMARQUE

AVERTISSEMENT

ATTENTION
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fonctions de base
CONTENU
Votre nouveau lecteur MP3 est fourni avec les accessoires présentés 
ci-dessous. Si l’un de ces éléments ne se trouve pas dans l’emballage, contactez le 
service clientèle de Samsung.

Lecteur Ecouteurs Câble USB

Il se peut que les accessoires livrés avec votre appareil soient légèrement différents de 
ceux illustrés.
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VOTRE LECTEUR MP3

Ecran tactile

Bouton Alimentation et Verrouillage
Appuyez ici une seule fois pour verrouiller 
l’écran tactile.
Appuyez une nouvelle fois pour déverrouiller 
l’écran tactile.
Appuyez longuement sur ce bouton pour 
éteindre/allumer le lecteur.

Haut-parleur

Bouton de réduction du volume
Appuyez sur le bouton pour diminuer le 
volume.

Haut-parleur

Bouton d’augmentation du volume
Appuyez sur le bouton pour augmenter le 
volume.

Témoin DEL

Microphone



fonctions de base _ 13

VOTRE LECTEUR MP3 (Suite)

Port USB

Ecouteurs
Pour votre confort, 
les lettres L 
(écouteur gauche) 
et R (écouteur droit) 
sont gravées sur 
chaque écouteur. 
Ce cordon sert 
également
d’antenne radio.

Prise pour écouteurs

Logement de carte mémoire externe
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REINITIALISATION DU SYSTEME
Si votre lecteur MP3 ne s’allume pas, ne lance pas de lecture de fi chier ou n’est pas 
reconnu par votre ordinateur lorsque vous le branchez, il est préférable de réinitialiser le 
système.

Appuyez sur le bouton [ ] et 
maintenez-le enfoncé pendant plus de 10 
secondes.

Le système est réinitialisé.
La fonction Reset (Réinitialisation) ne permet pas 
de supprimer les renseignements de durée et les 
données enregistrées dans la mémoire intégrée.
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CHARGEMENT DE LA BATTERIE
Chargez-la avant d’utiliser votre lecteur pour la première fois ou lorsque vous ne l’avez 
pas utilisé pendant une période prolongée.

1. Branchez l’extrémité la plus étroite du câble USB sur le port de connexion USB situé 
dans la partie inférieure du lecteur.

2. Raccordez l’extrémité la plus large du câble USB au port USB ( ) de votre 
ordinateur.

Durée de charge environ 3 heures

La durée de charge totale varie en fonction de votre environnement informatique. 

Le lecteur ne peut être chargé que via la connexion à l’ordinateur, à l’aide d'un câble USB. 
N’utilisez pas d’adaptateur CA USB séparé qui pourrait ne pas charger la batterie ou 
empêcher le lecteur de fonctionner correctement.

2
1

REMARQUE

Affi chage à l’écran

<USB connected> (USB connecté)

< > - Chargement

< > - Chargement terminé

ATTENTION
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ENTRETIEN DE LA BATTERIE
La batterie durera plus longtemps si vous respectez les consignes d’entretien et de 
rangement du lecteur.
• Rechargez la batterie dans un lieu où la température est comprise entre 5 et 35 °C.

• Evitez de surcharger la batterie (12 heures au maximum). Charger ou décharger la batterie à des 
fréquences trop rapprochées peut réduire sa durée de vie.

• Comme pour tout autre produit de consommation, la durée de vie de la batterie raccourcit 
progressivement avec le temps.

Si vous rechargez le lecteur via un ordinateur portable, assurez-vous que la batterie du 
portable est entièrement chargée ou que l’ordinateur est lui-même relié à une prise secteur.

La batterie rechargeable intégrée à ce produit ne peut pas être remplacée par l’utilisateur. 
Pour plus d’informations sur son remplacement, contactez votre fournisseur de services.

MISE SOUS ET HORS TENSION DE L’APPAREIL
Mise sous tension de l’appareil
Appuyez longuement sur le bouton [ ].

Mise hors tension de l’appareil
Appuyez longuement sur le bouton [ ].

Votre lecteur MP3 s’éteint automatiquement en l’absence de manipulation de bouton ou 
d’icône pendant 5 minutes alors que l’appareil est en mode pause.

REMARQUE

REMARQUE

ATTENTION
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CONTROLE DU VOLUME
Vous pouvez régler le volume en cours de lecture de fi chier.

Appuyez sur le bouton [ ], [ ] .

DÉSACTIVATION DE L’ÉCRAN TACTILE
La fonction de Verrouillage permet de désactiver l’écran tactile du lecteur MP3 ; ainsi, 
si vous appuyez sur un bouton par mégarde, au cours d’un exercice physique, par 
exemple, la musique ne sera pas interrompue pour autant.

1. Appuyez une seule fois sur le bouton [ ] .

2. Appuyez une fois sur le bouton [ ] pour 
désactiver la fonction Verrouillage.

Si vous réglez l’option <All> (Tout) via <Settings> (Paramètres)  <System> (Système) 
<Hold Option> (Option verrouillage), l’écran tactile ainsi que l’ensemble des boutons seront 
verrouillés. Reportez-vous à la page 45.

REMARQUE
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RECHERCHE DE FICHIERS A L’AIDE DU 
« DOSSIER NAVIGATEUR »
Recherchez des fi chiers en toute simplicité grâce la fonction <File 
Browser> (Dossier Navigateur).

1. Sélectionnez l’icône située sur l’écran du menu principal.

2. Sélectionnez un dossier souhaité pour accéder à la liste de ses 
fi chiers.

3. Sélectionnez le fi chier souhaité.
La lecture du fi chier démarre.

SUPRESSION DE FICHIERS A L'AIDE DU « DOSSIER 
NAVIGATEUR »
Suivez les étapes 1 à 2 ci-dessus.

3. Appuyez légèrement sur l’icône [  ] .

4. Sélectionnez <Delete> (Supprimer).

5. Sélectionnez le fi chier que vous souhaitez supprimer puis appuyez 
légèrement sur <OK> .

Appuyez légèrement sur l’icône [  ] pour sélectionner tous les fi chiers.

Le fi chier sélectionné est supprimé.

Vous pouvez supprimer un fi chier directement dans une liste de fi chiers en mode vidéo ou 
musique ainsi que dans <File Browser> (Dossier Navigateur).
Le fi chier sélectionné ne peut pas être supprimé en cours de lecture.

Une fois supprimés, les fi chiers ne peuvent plus être récupérés.

REMARQUE

ATTENTION
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VÉRIFICATION DES TÉMOINS D’ÉTAT
Les témoins d’état actuels du lecteur s’affi chent en haut de l’écran.

Témoin de l’alarme Témoin verrouillage

Témoin Bluetooth Heure actuelle

Témoin de la carte 
mémoire Etat de la batterie

Les représentations à l’écran fi gurent à titre indicatif uniquement. L’écran réel de votre 
appareil peut être différent.REMARQUE
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UTILISATION DE L’ECRAN TACTILE
Appuyez légèrement sur l’écran tactile avec votre pouce ou le bout du doigt.

N’exercez pas une pression excessive lorsque vous appuyez sur l’écran tactile car vous 
risqueriez de l’endommager.

Afi n de ne pas endommager l’écran tactile, servez-vous uniquement de votre pouce ou de 
votre doigt pour l’activer et n’utilisez aucun autre outil à cet effet.

Veillez toujours à avoir les mains propres avant d’appuyer sur l’écran.

N’utilisez jamais le pavé tactile mains gantées.

Il est possible que l’écran ne fonctionne pas si vous utilisez votre ongle ou un autre objet tel 
qu’un stylo à bille.

REMARQUE
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UTILISATION DE L’ECRAN TACTILE (Suite)

Appuyer légèrement
Appuyez légèrement sur la partie souhaitée de l’écran tactile.

Exemples
Pour sélectionner un 
élément ou passer à 
l’écran suivant

1. Exécutez une fonction en appuyant légèrement sur 
son icône ou sélectionnez un élément dans la liste.

Pour affi cher les 
informations sur la 
lecture et les icônes des 
fonctions

2. Appuyez légèrement sur l’écran tactile pour 
affi cher les informations de lecture et les icônes 
des fonctions vidéo, musique, image et affi chage 
de texte. 
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UTILISATION DE L’ECRAN TACTILE (Suite)

Appuyer longuement
Appuyez longuement sur la partie souhaitée de l’écran tactile.

Exemples

Retour sur l’écran de 
lecture précédent.

1. Appuyez longuement sur l’icône  ou  pour 
lire un fi chier récemment lu ou aller sur l’écran de 
lecture du fi chier actuellement sélectionné.

Création de chapitres 
vidéo

2. Appuyez longuement sur l’écran durant la lecture 
vidéo afi n de créer un total de 5 chapitres pour la 
vidéo en cours. 
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UTILISATION DE L’ECRAN TACTILE (Suite)
Glisser
Appuyez légèrement et faites glisser votre pouce ou vos doigts vers le point 
souhaité.

Exemples
Parcourir l’écran du 
menu principal

1. Faites un glisser horizontal sur un espace vide de l’écran 
tactile afi n de déplacer l’écran du menu principal.

Passage à la liste 
précédente/suivante

2. Vous pouvez consulter la liste suivante/précédente en 
faisant un glisser à la verticale sur l’écran de menu vidéo 
et musique.

Contrôle de la barre 
d’état de la lecture

3. Appuyez légèrement sur la barre d’état de la lecture 
affi chée à l’écran et faites glisser votre pouce ou votre 
doigt jusqu’au point souhaité avant de le relâcher.

Changement de 
page/recherche de 
lecture

4.

Effectuez un glissement horizontal en cours de lecture 
vidéo ou de lecture musicale pour faire un saut arrière ou 
avant, selon la direction du trait horizontal.
Effectuez un glissement horizontal sur l’écran d’affi chage 
de l’image pour accéder à l’image précédente/suivante.
Effectuez un glissement horizontal sur l’écran d’affi chage 
du texte pour accéder à la page précédente/suivante.

Déplacer les icônes 
de widget

5. Lors de l’utilisation de widgets, sélectionnez le menu 
principal ou l’icône de widget à déplacer et faites-la glisser 
jusqu’au point souhaité. 
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RÉGLAGE DE L’ÉCRAN DU MENU PRINCIPAL
Dans le menu principal, appuyez légèrement sur l’icône [ ] située en bas de l’écran afi n 
d’affi cher un menu contextuel qui vous permet de personnaliser le menu principal.

1
Vous pouvez changer le style du menu 
principal.

2

Vous pouvez personnaliser la 
disposition de l’écran du menu principal 
en déplaçant les différentes icônes du 
menu principal vers l’emplacement de 
votre choix.

3
Vous pouvez supprimer ou ajouter une 
icône de widget sur l’écran du menu 
principal.

Pour changer le style du menu principal
Sélectionnez un style de menu principal de votre choix.

1 2 3
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RÉGLAGE DE L’ÉCRAN DU MENU PRINCIPAL (Suite)

Pour changer la disposition de l’écran du menu principal
Appuyez légèrement sur l’icône de menu principal et faites-la glisser vers la 
page ou l’emplacement souhaité(e).

Faites glisser l’icône du menu principal vers la barre de menus inférieure afi n de 
supprimer l’icône du menu principal.

Ajout/suppression d’une icône de widget
Faites glisser une icône de widget depuis la barre de widgets vers l’écran du 
menu principal ou à l’inverse, de l’écran du menu principal vers la barre de 
widgets.
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ICÔNES DE WIDGETS
Un widget est un composant d’interface utilisateur graphique spécialisé qui s’affi che 
à l’écran pour fournir des informations visuelles et un accès facile aux fonctions 
fréquemment utilisées telles que l’horloge, le calendrier ou les notes.   Placez l’horloge, 
le calendrier et autres widgets sur l’écran de votre menu principal à votre convenance, 
pour y accéder de manière directe et aisée.

Affi che une horloge analogique et indique l’heure actuelle. Il est 
également possible de régler l’heure. Reportez-vous à la page 28.

Affi che une horloge numérique et indique l’heure actuelle. Il est 
également possible de régler l’heure. Reportez-vous à la page 28.

Vous pouvez prendre des notes et sauvegarder votre mémo. Reportez-
vous à la page 29.

Vous pouvez affi cher le calendrier ainsi que vos programmations. 
Reportez-vous à la page 30.

Vous pouvez consulter le fuseau horaire actuel de deux grandes villes 
du monde. Reportez-vous à la page 31.

Vous pouvez affi cher des images sauvegardées sur le lecteur en mode 
diaporama.
Vous pouvez sélectionner un dossier pour créer un diaporama. 
Reportez-vous à la page 32.
Appuyez légèrement sur l’ampoule pour régler la luminosité de l’écran 
tactile.

Vous pouvez défi nir également la luminosité dans <Settings> (Paramètres) 
<Display> (Affi cher)  <Brightness> (Luminosité). Reportez-vous à la page 42.
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ICÔNES DE WIDGETS (Suite)

Appuyez légèrement pour programmer l’heure de mise en veille de 
l’appareil. À l’heure programmée, l’appareil se met automatiquement 
hors tension.

Vous pouvez défi nir également l’heure de mise en veille dans <Settings> 
(Paramètres)  <System> (Système)  <Sleep> (Veille).
Reportez-vous à la page 45.

Vous pouvez vérifi er la capacité restante de la batterie.

Vous pouvez écouter la musique ou la radio FM depuis l’écran du menu 
principal sans passer en mode musique ou radio FM.

Élément décoratif montrant un papillon batifolant autour d’une fl eur.

Élément décoratif comportant des feuilles de fl eurs qui tourbillonnent 
lorsque l’on appuie légèrement dessus.

Élément décoratif représentant une tasse de café qui se met à fumer 
lorsque l’on appuie légèrement dessus.

Élément décoratif d’un petit gâteau qui s’effrite lorsque l’on appuie 
légèrement dessus. 
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UTILISATION DES WIDGETS

Pour régler l’heure actuelle

1. Appuyez légèrement sur le widget de l’horloge numérique 
ou analogique dans l’écran du menu principal.

2. Réglez les options <Year> (Année), <Month> (Mois), 
<Day> (Jour), <Hour> (Heure), <Min> (Min), <AM, PM>.

3. Appuyez légèrement sur <OK>.

Option de l’horloge 
<Style>: Vous pouvez modifi er le style du widget de l’horloge dans l’écran du menu 
principal.

Vous pouvez également régler l’heure actuelle dans <Settings> (Paramètres) 
<Time> (Heure)  <Date&Time> (Date et heure). Reportez-vous à la page 44.REMARQUE
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UTILISATION DES WIDGETS (Suite)

Pour saisir un mémo

1. Appuyez légèrement sur le widget du mémo dans l’écran 
du menu principal.

2. Sélectionnez <New Memo> (Nouveau mémo).

3. Entrez votre mémo puis appuyez légèrement sur <OK>.
Pour utiliser le clavier, reportez-vous en page 35.

Options de mémo 
<Style>: Vous pouvez modifi er le style du widget du mémo dans l’écran du 
menu principal.
<Delete> (Supprimer) : Vous pouvez supprimer un mémo stocké.

Régler comme mémo principal 
Affi che un mémo sur l’écran du menu principal.
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UTILISATION DES WIDGETS (Suite)

Pour affi cher le calendrier/programme
Vous ne pourrez consulter vos programmes que si le fi chier du programme 
(format de fi chier .ics) créé sous MS Offi ce Outlook a été transféré vers le 
dossier <File Browser> (Dossier Navigateur)  <My Pack> (Mon pack) 
<Calendar> (Calendrier) du lecteur.

1. Appuyez légèrement sur le widget du calendrier dans 
l’écran du menu principal.

2. Sélectionnez le mois souhaité.
Faites glisser le pouce ou les doigts à la verticale pour 
sélectionner le mois souhaité. Faites glisser le pouce ou les doigts 
à l’horizontale pour sélectionner l’année souhaitée.

3. Sélectionnez une date à l’aide de l’icône de programmation 
dans le calendrier.

4. Sélectionnez le calendrier souhaité.
Vous pouvez consulter votre programme.

Options de calendrier/programme
<Style>: Vous pouvez modifi er le style du widget de calendrier dans l’écran du menu 
principal.
<Delete All Schedule> (Suppr tt calendrier) : Supprime tous les programmes 
sauvegardés.

Il est impossible de créer un programme sur le lecteur.
REMARQUE
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UTILISATION DES WIDGETS (Suite)

Pour changer le réglage de l’horloge de l’heure mondiale

Vous pouvez vérifi er l’emplacement et les date et heure des principales villes 
à travers le monde en vous basant sur leurs fuseaux horaires respectifs.

Avant de démarrer - Vous devez tout d’abord régler l’horloge. Reportez-vous à la 
page 44. 
Réglez le fuseau horaire souhaité dans <Setting> (Paramètres) <Time> (Heure) 

<Time Zone> (Fuseau hr). Reportez-vous à la page 44.

1. Appuyez légèrement sur le widget de l’heure mondiale dans 
l’écran du menu principal.

Vous pouvez régler l’heure mondiale à la fois en haut et en bas 
de l’écran.

2. Sélectionnez un fuseau horaire et appuyez légèrement sur 
<OK>.

Option de l’horloge de l’heure mondiale 
<Style>: Vous pouvez modifi er le style du widget de l’heure mondiale dans l’écran du 
menu principal.
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UTILISATION DES WIDGETS (Suite)

Visionner un diaporama

Appuyez légèrement sur le widget du diaporama dans l’écran 
du menu principal.

Le diaporama démarre.

Durant le diaporama, appuyez légèrement une seule fois sur 
l’écran pour affi cher l’icône sur laquelle vous avez défi ni des 
options.

Options du diaporama 
<Select Slideshow Folder> (Sélect. dossier diaporama): Vous pouvez sélectionner 
un dossier de votre choix et faire apparaître les images qu’il contient au sein d’un 
diaporama. Les images du dossier sélectionné s’affi chent dans le diaporama de manière 
aléatoire.
<Change Frame> (Changer cadre) : vous pouvez modifi er la forme du cadre du widget 
du diaporama dans l’écran du menu principal.
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UTILISATION DU TIROIR DU MINI-LECTEUR OU DU TIROIR 
RAPIDE

Ouverture du tiroir du mini-lecteur ou du tiroir rapide 

Appuyez légèrement sur le haut de l’écran tactile.

Fermeture du tiroir du mini-lecteur ou du tiroir rapide

Appuyez légèrement sur l’écran tactile.

Pour utiliser le mini-lecteur

Vous pouvez écouter de la musique ou la radio FM sans basculer en mode 
musique ou radio FM en utilisant le mini-lecteur.

Appuyez légèrement sur l’icône [ , ,  ] pour 
effectuer un saut avant/arrière ou pour interrompre la lecture.

Vous ne pouvez pas régler la barre d’état de la lecture du mini-
lecteur.REMARQUE
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1 2 3 4

UTILISATION DU TIROIR DU MINI-LECTEUR OU DU TIROIR 
RAPIDE (suite)

Pour utiliser le tiroir rapide

Fournit un accès rapide au menu principal, sélectionne la sortie de son, 
la fonction Verrouillage et Affi ch. Désactivé ainsi que la connexion à un 
casque stéréo Bluetooth.

1
Permet d’accéder à l’écran du menu 
principal.

2

Règle la sortie du son sur Speaker 
(Haut-parleur) ou Earphone (Écouteurs). 

Sélectionnez les icônes [  ] (Auto), 
[  ] (Earphone) ou [  ] (Speaker) 
Reportez-vous à la page 41.

3

Désactivez l’écran et verrouillez l’écran 
tactile.
Ceci vous permet d’écouter le son tout 
en économisant l’énergie de la batterie. 

4

Ceci connecte ou déconnecte 
automatiquement un casque d’écoute 
Bluetooth.

Si le casque d’écoute stéréo Bluetooth 
n’est pas enregistré, vous ne pourrez 
pas le connecter. Pour de plus amples 
informations, consultez la section
<Utilisation des ecouteurs stereo 
Bluetooth>. Reportez-vous à la page 108.
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UTILISATION DU CLAVIER VIRTUEL
Vous pouvez utiliser le clavier virtuel pour saisir le texte dans le widget du mémo, 
entrer vos informations personnelles et renommer un périphérique Bluetooth. 

Saisie de texte

Utilisez le clavier virtuel pour saisir le texte puis appuyez légèrement sur <OK>.

Le mode de saisie change selon 
l’ordre de caractères de l’étiquette 
du bouton.

Ex. [Aa1] : Le mode de saisie change 
selon l’ordre suivant : Majuscule latine 

 Minuscule latine  Numéro.

Déplace le curseur en arrière/avant.

Vous permet de supprimer les 
caractères l’un après l’autre.

Permet d’ajouter un espace entre les 
caractères.

Vous pouvez insérer des sauts de 
lignes.

Efface le texte tout entier.

Le type de clavier varie selon les conditions d’utilisation.
REMARQUE
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CHANGEMENT DU MODE DE LISTAGE
Vous pouvez changer le mode de listage en cours (mode vidéo, musique ou texte) selon 
le mode d’affi chage de votre choix.

Vidéos

En mode d’affi chage vignette, vous pouvez vérifi er la dernière scène exécutée et 
l’heure de lecture d’une vidéo.

Musique

Vous pouvez changer de mode d’affi chage en sélectionnant <Album> (Album) dans 
la liste musicale.

REMARQUE

REMARQUE
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CHANGEMENT DU MODE DE LISTAGE (suite)

Images

Textes

Vous pouvez vérifi er l’état d’avancement de la lecture du texte que vous lisez.
REMARQUE
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CONNEXION À UN TELEVISEUR
Connectez le lecteur au téléviseur via un câble de sortie TV-OUT supplémentaire afi n 
de visionner sur l’écran du téléviseur des fi chiers multimédia tels que des photos ou des 
vidéos.

Avant de démarrer - Dans <Settings> (Réglages)  <System> (Système)  <TV out Type> 
(Type sortie TV), réglez le mode sortie de votre téléviseur selon la région où vous vous 
trouvez. Reportez-vous à la page 45.

1. Connectez votre lecteur à un téléviseur à l’aide du câble TV-OUT 
(SORTIE TV) (en option).

2. Réglez la source d’entrée vidéo/audio de votre téléviseur en fonction de la connexion 
du câble correspondant.

3. Sélectionnez la vidéo ou la photo de votre choix sur le lecteur.
4. Appuyez légèrement sur l’icône [  ].
5. Sélectionnez <TV out> (Sortie TV).

L’écran du téléviseur affi che la photo ou la vidéo que vous êtes en train de visionner sur votre 
lecteur.

En mode TV out (Sortie TV), le son est émis uniquement depuis l’enceinte du téléviseur.
Certaines fonctionnalités de votre lecteur peuvent être indisponibles lorsque celui-ci est 
connecté à un téléviseur.
En mode Sortie TV, appuyez légèrement sur l’icône [  ] pour quitter le mode.

REMARQUE
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UTILISATION DE LA ROTATION D’ECRAN
Le lecteur est équipé d’un capteur à trois axes, qui détecte l’angle d’inclinaison et fait 
tourner l’écran à la verticale ou à l’horizontale en conséquence.

Faites tourner le lecteur de côté pour obtenir une vue horizontale.

Cette fonction est disponible dans certains modes d’affi chage d’écrans de listes, de musique, 
d’image et de texte. REMARQUE
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MODIFICATION DES REGLAGES ET DES PREFERENCES
Vous pouvez modifi er les valeurs préréglées en usine pour véritablement personnaliser 
votre lecteur MP3.

1. Sélectionnez l’icône  située sur l’écran du menu principal.

2. Sélectionnez l’élément souhaité dans la liste de réglages.

3. Sélectionnez l’option de réglage de votre choix.

4. Réglez les options de votre choix.

[Liste de réglages]
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)

Options de réglage du son
Vous pouvez régler les options Master EQ (EG princ.), Touch Tone et Volume 
Wise, etc. 

Street Mode (Mode Rue): Permet d’écouter clairement en extérieur 
grâce au fi ltrage de certains bruits de la rue.
Audio Upscaler (Mise à l’échelle audio): Cette fonction effectue 
une mise à l’échelle audio de sorte que le son se rapproche de sa 
condition d’origine. 
myDNSe : Vous pouvez régler les options DNSe selon vos 
préférences. Vous pouvez régler jusqu’à 2 options myDNSe.
Vibe Woofer: Vous pouvez faire l’expérience de différents effets de 
vibration selon la force du battement de son. Vous pouvez régler 
l’option en fonction de la musique ou de la vidéo.
Touch Tone: Vous pouvez régler le volume du signal Touch Tone et son niveau de 
vibration.
Notifi cation/Alert tone (Notifi cation/tonalité d’alerte): Vous pouvez régler le volume du 
son et les réglages de vibration de l’alerte et confi rmer les fenêtres contextuelles.
Wise Volume (Volume Wise): Vous pouvez diminuer les risques 
de troubles auditifs en réglant l’intensité du volume sonore lors de 
l’utilisation des écouteurs.Lorsqu’il est spécifi é sur <On> (Marche), le message 
d’avertissement s’affi chera si vous vous êtes exposé à des niveaux de volume plus 
élevés sur une période de temps prolongée. Le volume sera alors automatiquement 
réglé sur des niveaux modérés. Le niveau de volume maximal lorsque l’option Volume 
Wise est spécifi ée sur <Off> (Arrêt) est de 30. Même si vous avez sélectionné <Off> 
(Arrêt), le volume sera à nouveau spécifi é sur la valeur 15 à la remise sous tension du 
lecteur afi n de vous éviter le risque d’une diminution de votre acuité auditive.
Output (Sortie): Vous pouvez régler la sortie du son sur le haut-parleur ou les écouteurs.  
Si vous sélectionnez <Auto>, vous entendrez le son via les écouteurs connectés, lorsque 
c’est le cas, autrement le son retentit du haut-parleur intégré.
Master EQ (EG princ.): Vous pouvez optimiser les réglages du son. Sélectionnez la 
fréquence souhaitée et son niveau. 
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)

Options de réglage de l’affi chage
Changez la police, le délai de désactivation de l’affi chage, la luminosité de votre 
écran, etc.

Font (Police): Vous pouvez modifi er le type de police de la langue 
du menu. Il est possible que pour certaines langues, l’option <Font> 
(Police) ne soit pas sélectionnée.
Random Skin (Habillage aléatoire): Vous pouvez défi nir un fi chier 
image dans le dossier <Pictures> (Images) <Skin> (Habillage) 
comme votre habillage aléatoire d’arrière-plan à la mise sous 
tension du lecteur. 
Pour de plus amples informations sur l’enregistrement des images 
dans le dossier <Skin> (Habillage), reportez-vous en page 78.
Sélectionnez <Assign> (Affecter)  <Set as My Skin> (Défi nir 
comme habillage) dans le menu Picture (Image) après avoir réglé 
Random Skin (Habillage aléatoire) sur <On> (Marche). L’option 
Random Skin (Habillage aléatoire) bascule alors automatiquement 
sur <Off> (Arrêt).
Reset My Skin (Réinitialiser mon habillage): Permet d’initialiser l’image de fond de 
l’écran tactile par l’image par défaut. Sélectionnez <Yes> (Oui) pour réinitialiser l’image 
en arrière-plan.
Reset Booting Image (Réinit. image démarrage): Réinitialise l’image au démarrage 
(image affi chée au lancement du lecteur) sur sa valeur par défaut. Sélectionnez <Yes> 
(Oui) pour réinitialiser l’image au démarrage. Pour régler l’image au démarrage, reportez-
vous en page 78.
Display Off & Hold (Aff désact et verr) : Si aucun bouton ni aucune icône n’est 
actionné(e) pendant la durée défi nie, l’écran tactile s’éteindra automatiquement. Dès que 
l’écran tactile s’éteint, il est verrouillé.
Brightness (Luminosité): Vous pouvez régler la luminosité de l’écran.
LED Effect (Effet DEL) : Vous pouvez régler la lumière de la DEL de sorte à l’allumer ou 
l’éteindre.
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)

Options de réglage de la langue
De nombreuses langues sont disponibles pour l’affi chage des menus 
de votre nouveau lecteur MP3. Vous pouvez changer facilement de 
préférence de langue.

Menu : Permet de régler la langue du menu.
Options disponibles <English>, < >, <Français>, 
<Deutsch>, <Italiano>, < >, < >, <

>, <Español>, < >, <Magyar>, <Nederlands>, 
<Polski>, <Português>, <Svenska>, < >, < eština>,
< >, <Türkçe>, <Norsk>, <Dansk>, <Suomi>, 
<Español(Sudamérica)>, <Português(Brasil)>, <Indonesia>, 
<Ti ng Vi t>, < >, <Romani>, < >,
<Slovenš ina> et  <Slovenský>.

Contents (Sommaire) : Vous permet de régler la langue 
dans laquelle les informations de suivi et le texte seront 
affi chés. Options disponibles <English>, <Korean>, 
<French>, <German>, <Italian>, <Japanese>, <Chinese(S)>, <Chinese(T)>, <Spanish>, 
<Russian>, <Hungarian>, <Dutch>, <Polish>, <Portuguese>, <Swedish>, <Thai>, 
<Finnish>, <Danish>, <Norwegian>, <Farsi>, <Afrikaans>, <Basque>, <Catalan>, 
<Czech>, <Estonian>, <Greek>, <Hrvatski>, <Icelandic>, <Romanian>, <Slovak>, 
<Slovene>, <Turkish> et <Vietnamese>.

Les langues prises en charge peuvent être modifi ées ou ajoutées.
REMARQUE
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)

Options de réglage de l’heure
Le réglage de l’heure vous permet de spécifi er les options date&time (Date et 
heure), Date type (Type date) et même Time Zone (Fuseau hr).

Date&Time (Date et heure) : Permet de régler la date et l’heure 
actuelles. Appuyez légèrement sur le haut ou le bas des chiffres 
dans les icônes <Year> (An), <Month> (Mois), <Day> (Jour), 
<Hour> (Heure), <Min> et <AM, PM> pour régler l’heure actuelle.
Date Type (Type date) : Permet de régler le type d’affi chage de 
l’heure de l’horloge universelle.
Time Zone (Fuseau hr) : Vous pouvez consulter l’heure actuelle 
en sélectionnant le fuseau horaire d’une ville internationale 
spécifi que. Vous devez commencer par régler le fuseau horaire 
pour pouvoir affi cher les informations relatives à l’heure mondiale. 
Reportez-vous à la page 31.
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Options de réglage du système
Sélectionnez le mode veille ainsi que le réglage par défaut appropriés.

My Info: Vous permet de saisir votre nom et votre date de naissance.
Réglage du nom- Appuyez légèrement sur la zone d’entrée 
située sous <My Name> (Mon nom) et entrez-y votre nom.
Pour utiliser le clavier, reportez-vous en page 35.
Réglage Mon anniversaire - Appuyez légèrement sur le haut 
ou le bas des chiffres dans les icônes <Year> (An), <Month> 
(Mois), <Day> (Jour), sous <My Birthday> (Mon anniv.) pour 
défi nir votre date d’anniversaire.

Sleep (Veille): Permet d’éteindre automatiquement l’appareil après 
l’écoulement de la durée préréglée.
Auto Pivot (Pivot automatique) : Vous pouvez régler la rotation automatique de l’écran 
de sorte à activer ou désactiver cette option.
PC Connection (Connexion PC): vous pouvez régler la connexion USB à l’ordinateur sur 
<MTP> ou <MSC>. Par défaut (réglage d’usine), la connexion PC est réglée sur <MTP>. 
Sélectionnez <MSC> pour utiliser le lecteur comme périphérique de stockage amovible. 
Reportez-vous à la page 47.
TV out Type (Typ sort TV) : Pour affi cher les vidéos ou les photos stockées sur le lecteur 
d’un téléviseur, vous devez sélectionner le même système de téléviseur (PAL/NTSC) que 
celui du téléviseur connecté.
Hold Option (Option verrouillage): Vous pouvez sélectionner la fonction de verrouillage 
pour verrouiller tous les boutons ou uniquement l’écran tactile. Reportez-vous à la page 
17.
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)

Options de réglage du système (Suite)

Default Set (Réglage par défaut): Permet de revenir aux valeurs de réglage par défaut. 
Options disponibles.
Format (Formater): Vous permet de formater la mémoire interne. Le réglage sur <Yes> 
(Oui) formate la mémoire interne et supprime tous les fi chiers du lecteur.
vérifi ez avant de lancer le formatage.
About (A propos de): Permet de vérifi er la version du micrologiciel et la capacité de la 
mémoire.

Firmware - Affi che la version actuelle du micrologiciel.
Memory (Mémoire) - <Used> (Utilisé) indique la mémoire actuellement utilisée, 
<Remaining> (Mémoire restante) indique la capacité restante de la mémoire et 
<Total> indique la capacité totale de la mémoire.

Vous devez disposer d’un minimum de 300 Mo d’espace libre sur votre lecteur pour 
effectuer la mise à niveau.

A propos de la mémoire intégrée
1 Go=1,000,000,000 octets : la capacité réelle formatée peut être inférieure, car le 
micrologiciel interne en utilise une partie. 

REMARQUE
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Lorsque la connexion pc est réglée sur <MSC>
Transfert de fi chier vers un disque amovible
Lorsque le lecteur est connecté à l’ordinateur, il est reconnu par celui-ci comme 
étant le disque amovible sur lequel vous pouvez transférer les fi chiers souhaités 
vers et depuis l’ordinateur.

Avant de démarrer – Branchez le lecteur sur l’ordinateur.

1. Ouvrez les fi chiers/dossiers à transférer en passant par l’ordinateur.
2. Allez dans <My Computer> (Poste de 

travail) <M1> à partir du bureau.
3. Sélectionnez les fi chiers/dossiers que 

vous souhaitez transférer depuis votre 
ordinateur et faites-les glisser vers le 
dossier de votre choix dans <M1>

Les dossiers ou fi chiers sélectionnés sont 
transférés vers le lecteur.

L’ordre dans lequel les fi chiers musicaux sont affi chés 
dans votre ordinateur peut être différent de l’ordre de 
lecture des fi chiers sur votre lecteur.
Si vous transférez un fi chier DRM (Gestion des droits numériques) vers le lecteur, 
celui-ci ne pourra pas être lu.

Utilisez le système de fi chiers FAT 32 pour le formatage du lecteur sur votre 
ordinateur. Sous Windows Vista, cliquez sur « Restore device defaults » 
(Restaurer les paramètres par défaut du périphérique) et formatez-le.
Qu’est-ce que le système DRM ?
La technologie et le service Gestion des droits numériques (Digital Rights Management, 
DRM) permettent d’empêcher toute utilisation illégale de données numériques et de 
protéger les détenteurs de droits d’auteur. Les fi chiers DRM sont des fi chiers musicaux 
équipés d’une technologie de protection contre les copies illégales.

REMARQUE

ATTENTION
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)

Lorsque la connexion pc est réglée sur <MSC> (Suite)

Débrancher l’appareil de l’ordinateur
Suivez les étapes ci-dessous pour éviter d’endommager le lecteur et les 
données au moment du débranchement.

1. Positionnez le curseur de la souris 
sur l’icône  de la barre des tâches 
située en bas à droite du bureau et 
cliquez sur le bouton gauche de la 
souris.

2. Cliquez sur le message <Safely
Remove USB Mass Storage 
Device Drive>(Retirer le lecteur 
USB grande capacité en toute 
sécurité).

3. Vous pouvez à présent débrancher 
le lecteur de l’ordinateur.

Ne débranchez jamais le lecteur de 
l’ordinateur pendant un transfert de 
fi chier. Ceci risque d’endommager le 
lecteur ou l’ordinateur.
Vous ne pouvez pas retirer le 
périphérique pendant que des fi chiers 
du lecteur sont en cours de lecture sur 
l’ordinateur. Veuillez réessayer une fois 
la lecture des fi chiers terminée.

ATTENTION

1

2
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EmoDio
EmoDio est une application logicielle fournie avec ce lecteur MP3 qui est 
destinée à la prise en charge de divers services aux contenus et de différents 
supports de périphérique. 
EmoDio peut faire l’objet de modifi cation sans préavis, aux fi ns d’améliorer le 
produit.

Avant de démarrer - Pour l’installation de l’application <EmoDio>, reportez-vous au Guide 
de référence rapide du lecteur.
Connectez le lecteur à l’ordinateur puis lancez <EmoDio>.

CONFIGURATION REQUISE
Votre ordinateur doit être conforme à la confi guration minimale requise suivante pour 
que vous puissiez installer et exécuter EmoDio :

• Windows XP Service Pack 2 ou ultérieur
• Windows Media Player 11 ou ultérieur
• Pentium 500 MHz ou plus
• Résolution 1024 X 768 ou plus
• Internet Explorer 6.0 ou version ultérieure
• DirectX 9.0 ou version ultérieure
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UTILISATION D’EMODIO
L’application logicielle EmoDio est facile à utiliser et vous permet de classer vos 
fi chiers sur votre ordinateur. Une fois vos fi chiers classés et organisés dans EmoDio, 
vous pouvez les transférer rapidement vers votre lecteur MP3 sans avoir à faire des 
recherches sur l’ensemble de votre disque dur pour retrouver le bon fi chier.

Le programme <EmoDio> est le moyen le plus simple de transmettre des fi chiers 
de votre ordinateur vers votre lecteur MP3.

Grâce à <EmoDio>, vous créez votre propre collection ou liste de lecture ainsi que 
vos fi chiers audio originaux.

Vous pouvez transférer vers le lecteur les informations relatives au blog et les 
fi chiers enregistrés au format RSS.
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UTILISATION D’EMODIO (Suite)

Transfert de fi chiers vers le lecteur à l’aide d’EmoDio

1. Connectez le lecteur à votre ordinateur via le câble USB.
<EmoDio> démarre automatiquement lorsque vous branchez le lecteur sur votre 
ordinateur.

2. Cliquez sur <My PC> (Mon PC).

3. Cliquez sur <Add Folder> (Ajouter dossier) ou <Add File> (Ajouter fi chier) 
en bas de <EmoDio>.

4. Sélectionnez un dossier ou un fi chier à ajouter.
Le dossier ou fi chier sélectionné s’affi che dans la liste de fi chiers sous <EmoDio> .

5. Dans la liste sous <EmoDio>, sélectionnez le fi chier à transférer.

6. Cliquez sur l’icône [  ].
Le fi chier sélectionné est transféré vers le lecteur.

Ne débranchez jamais le câble USB durant le transfert de fi chiers ; vous risqueriez 
d’endommager le lecteur ou l’ordinateur.
Branchez le lecteur directement sur l’ordinateur plutôt que sur un Hub USB afi n d’éviter une 
mauvaise connexion.

Pour plus d’informations sur <EmoDio>, cliquez sur <MENU> <Help> (Aide) <Help>
(Aide) en haut du programme <EmoDio>.
La technologie de reconnaissance musicale et les données relatives sont fournies par 
Gracenote et Gracenote CDDB® Music Recognition ServiceSM.
CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote, le logo 
et le logotype Gracenote CDDB et le logo «Powered by Gracenote CDDB» sont des marques 
déposées de Gracenote. Music Recognition Service et MRS sont des marques de service de 
Gracenote.

REMARQUE

ATTENTION
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regarder une vidéo
L’encodage de fi chiers n’étant pas nécessaire, vous bénéfi ciez d’une image 
aussi claire et nette que l’original.

Avant de démarrer - Allumez le lecteur et vérifi ez l’état de la batterie.

REGARDER UNE VIDÉO

1. Sélectionnez l’icône  située sur l’écran du menu principal.

2. Sélectionnez un fi chier vidéo à lire.
La lecture du fi chier vidéo sélectionné démarre horizontalement.

Lorsque vous téléchargez des fi chiers non pris en charge sur votre lecteur avec EmoDio, 
EmoDio convertit automatiquement les formats de fi chier afi n que vous puissiez les lire sur 
votre lecteur.
Certains fi chiers de formats Divx et wmv peuvent ne pas être correctement lus.

REMARQUE
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AFFICHAGE DE LA LECTURE VIDÉO
Appuyez légèrement sur l’écran pour affi cher les informations relatives à la lecture vidéo 
ainsi que les icônes correspondantes.

1 Témoin du mode DNSe 6 Témoin Lecture/Pause/Recherche

2 Durée de lecture actuelle/totale 7 Nom du fi chier

3 Barre d'état de la lecture 8 Icône de retour en arrière

4 Icône de signet 9 Icône de menu

5 Icône Lecture/Pause/Recherche

Les représentations à l’écran fi gurent à titre indicatif uniquement. L’écran réel de votre 
appareil peut être différent.REMARQUE
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ICÔNES TACTILES POUR COMMANDER LA LECTURE

Appuyez légèrement une seule fois, 3 secondes après le lancement du 
fi chier actuellement sélectionné pour commencer la lecture en début de 
fi chier. 
Appuyez légèrement deux fois, 3 secondes après le lancement du 
fi chier actuellement sélectionné pour commencer la lecture du fi chier 
précédent.
Appuyez longuement pour revenir en arrière dans le fi chier actuellement 
sélectionné.

Appuyez légèrement pour introduire une pause dans la lecture.

Appuyez légèrement pour reprendre la lecture.

Appuyez légèrement pour reproduire le fi chier suivant.
Appuyez longuement pour avancer dans le fi chier actuellement 
sélectionné.
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CRÉATION DE CHAPITRES
Vous pouvez créer automatiquement 5 chapitres au sein de la vidéo actuelle. Il suffi t 
alors d’appuyer légèrement sur le chapitre souhaité pour y accéder directement.

1. Appuyez longuement sur l’écran en cours de lecture 
vidéo.

Les chapitres seront ainsi créés.

2. Sélectionnez le chapitre de votre choix.
Le lecteur lance la lecture de la vidéo à partir du chapitre 
sélectionné.

Pour retourner sur l’écran précédent, appuyez légèrement sur n’importe quelle zone située à 
l’extérieur des chapitres.

CAPTURE D’ÉCRAN
Vous pouvez capturer et sauvegarder la scène de votre choix durant la lecture vidéo.

1. Arrêtez la lecture de la vidéo sur la scène souhaitée.

2. Appuyez légèrement sur l’icône [ ].
La scène sera sauvegardée via <File Browser> 
(Dossier Navigateur)  <Pictures> (Images)  <Captured> 
(Capturé) au format bmp.
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UTILISATION D’UN SIGNET

Réglage d'un signet
Lorsque vous ajoutez à vos favoris une scène spécifi que que vous souhaitez 
voir à nouveau, vous pouvez la regarder à tout moment.

1. Appuyez légèrement sur l’icône [  ] pour 
affi cher la scène souhaitée durant la lecture de 
la vidéo.

2. Sélectionnez <Add Bookmark>
(Ajouter signet).

La position de lecture/d’arrêt actuelle est défi nie comme signet.
Le symbole [ ] apparaît dans la barre de progression de la lecture.

Vous pouvez défi nir un signet pour chaque fi chier vidéo.

La position du signet peut être légèrement différente de la position réelle.

Accéder à lire/Supprimer un signet

1. Appuyez légèrement sur l’icône [  ] située 
sur l’écran de lecture de la vidéo.

2. Sélectionnez <Go to Bookmark>
(Accéd. à signet) ou <Delete Bookmark>
(Supprimer signet).

Une fois l’option <Go to Bookmark> (Accéd. à Signet) sélectionnée, vous accédez au 
signet sélectionné et la lecture démarre à partir de ce signet.
L’option <Delete Bookmark> (Supprimer signet) permet de supprimer le signet 
sélectionné du fi chier vidéo.

REMARQUE
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UTILISATION DU MENU VIDÉO

Avant de démarrer - [  ] pour affi cher la scène souhaitée durant la lecture de la 
vidéo.

Régler la fonction Digital Natural Sound engine (DNSe)
Permet de choisir le type de son convenant le mieux à chaque genre de 
vidéo.

1. Sélectionnez <DNSe>.

2. Sélectionnez le DNSe souhaité.

Qu’est-ce que la fonctionnalité DNSe ?
La technologie Digital Natural Sound Engine (DNSe) est une fonction d’optimisation 
du son conçue par Samsung pour les lecteurs MP3. Cette option offre différents 
réglages sonores visant à améliorer le type de musique que vous écoutez.

Régler la luminosité
Vous pouvez régler la luminosité de l’écran vidéo.

1. Sélectionnez <Display> (Affi cher) 
<Brightness> (Luminosité).

2. Sélectionnez la valeur de la luminosité 
souhaitée puis appuyez légèrement sur <OK> .

Le menu de réglage de la luminosité ne peut être réglé qu’à l’écran vidéo.

REMARQUE

REMARQUE
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UTILISATION DU MENU VIDÉO (Suite)

Sélectionner la taille de l’écran
Vous pouvez sélectionner la taille de l’affi chage lors de la lecture de la vidéo.

1. Sélectionnez <Display> (Affi cher) <Screen
Size> (Taille écran).

2. Sélectionnez la taille de l’écran souhaitée.

Menu de taille d’écran

    <Standard> <Full> (Plein écran)            <Zoom>

Sur certains fi chiers vidéo, il peut s’avérer impossible de régler la taille de l’écran.
REMARQUE
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UTILISATION DU MENU VIDÉO (Suite)

Affi cher les sous-titres
Vous pouvez lire une vidéo et ses sous-titres lorsqu’ils sont inclus.

1. Sélectionnez <Display> (Affi cher) 
<Subtitle> (Ss-titre) <View> (Aff).

2. Appuyez légèrement sur <On> (Marche) ou 
<Off> (Arrêt).

Chaque pression sur <On> (Marche) ou <Off> 
(Arrêt) entraîne un basculement entre l’activation/
désactivation de l’option de sous-titrage. 

Seul le format de fi chier smi est pris en charge pour les sous-titres.
Le nom du fi chier de sous-titres doit correspondre à celui du fi chier vidéo à lire.
- Par ex.) Fichier vidéo : Vidéo Track.avi/Fichier sous-titre : Vidéo Track.smi.
Si le sous-titrage n’apparaît pas durant la lecture vidéo, le menu <Subtitle> (Ss-
titre) ne sera pas sélectionné.

Régler la synchronisation des sous-titres
Si les sous-titres défi lent plus rapidement que la vidéo, vous pourrez régler 
le temps de synchronisation pour faire correspondre images et sous-titres.

1. Sélectionnez <Display> (Affi cher) 
<Subtitle> (Ss-titre) <Sync> (Sync).

2. Sélectionnez une option horaire et appuyez 
légèrement sur <OK>.

Si vous quittez le mode vidéo après avoir réglé la synchronisation des sous-titres, 
le temps de synchronisation devra être à nouveau défi ni.

REMARQUE

REMARQUE
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UTILISATION DU MENU VIDÉO (Suite)

Régler le trait horizontal
Vous pouvez avancer rapidement dans un fi chier à intervalles variés lorsque 
vous appuyez à droite ou à gauche de l’écran. Sautez l’ensemble d’un 
fi chier ou sautez plusieurs secondes à la fois.
1. Sélectionnez <Horizontal Stroke>

(Trait horizontal).
2. Sélectionnez le trait horizontal de votre choix.

Si l’option <Seek> (Rechercher) est spécifi ée, faites 
glisser le pouce ou les doigts vers la gauche/droite 
pour alterner entre les vitesses de lecture <x2>  <x4>  <x8>.

L’intervalle du trait horizontal peut être différent de l’intervalle de saut réel en 
fonction du fi chier.

Régler la vitesse de lecture
Accélérez ou ralentissez votre vidéo préférée en réglant la vitesse de lecture.
1. Sélectionnez <Play Speed> (Vitesse de lecture).
2. Sélectionnez la vitesse de lecture souhaitée puis 

appuyez légèrement sur <OK>.

Sur certains fi chiers vidéo, il peut s’avérer 
impossible de régler la vitesse de lecture.
Vous ne pouvez pas sélectionner l’option <Play Speed> (Vitesse de lecture) 
lorsque le lecteur est connecté au casque d’écoute stéréo Bluetooth.

Pour visionner la vidéo sur l’écran du téléviseur
Vous pouvez apprécier la projection de la vidéo actuelle sur l’écran du 
téléviseur. Pour plus d’informations, reportez-vous en page 38.

REMARQUE

REMARQUE
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lecture de fi chiers musicaux
Vous pouvez lire et apprécier différents formats musicaux.

Avant de démarrer - Allumez le lecteur et vérifi ez l’état de la batterie.

LECTURE PAR CATEGORIE

1. Sélectionnez l’icône  située sur l’écran du menu principal.

2. Sélectionnez l’élément souhaité dans la liste musicale.

3. Sélectionnez un fi chier musical à lire.
La lecture du fi chier musical démarre.
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LECTURE PAR CATEGORIE (Suite)

Liste de fi chiers musicaux
Les informations sur le fi chier comprenant le nom de l’artiste, le nom de l’album, le titre de la 
plage et le genre s’affi chent en fonction des informations fi gurant sur l’étiquette ID3 du fi chier 
musical correspondant. Un fi chier sans étiquette ID3 s’affi che comme [Unknown] (inconnu).

Now Playing (En lecture): Permet de lire le fi chier lu en dernier ou d’affi cher l'écran de 
lecture du fi chier en cours.
Artists (Artiste): Lecture par artiste

Albums : Lecture par album. L’image de la pochette s’affi che

Songs (Chansons): Lecture en ordre numérique ou alphabétique. Pour le fi chier 
récemment exécuté ou en cours d’exécution, le symbole [ ] apparaît dans le coin droit.
Genres: Lecture par genre

Playlists (Playlist): Lecture par liste

Recently Added (Ajout récent ): Affi che 3 listes de fi chiers récemment ajoutés par 
date.

Recorded Files (Fichiers Enregistrés): Affi che tous les fi chiers enregistrés.

Music Browser (Navig. musique): Permet d’affi cher tous les fi chiers musicaux 
enregistrés dans le dossier musical.

Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations relatives au fi chier 
telles que le titre, l’artiste, l’album, l’année, le genre et un champ commentaire.

REMARQUE
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AFFICHAGE DE LA LECTURE MUSICALE
Appuyez légèrement sur l’écran pour affi cher les icônes de la lecture musicale.

1
Témoin de lecture de la plage en 
cours/du nombre total de plages

2 Ecran Lect mus.

3 Témoin du mode Lecture

4 Durée de lecture actuelle/totale

5 Icône Lecture/Pause/Recherche

6 Icône de répétition A-B

7 Icône de menu

8 Témoin Lecture/Pause/Recherche

9 Témoin du menu associé

10 Titre de la plage

11 Barre d'état de la lecture

12 Témoin du mode DNSe

13 Icône de retour en arrière

Les représentations à l’écran fi gurent à titre indicatif uniquement. L’écran réel de votre 
appareil peut être différent.REMARQUE
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ICÔNES TACTILES POUR COMMANDER LA LECTURE

Appuyez légèrement une seule fois, 3 secondes après le lancement 
de la lecture, pour lire le début de la piste actuellement sélectionnée.
Appuyez légèrement deux fois, 3 secondes après le lancement de la 
lecture, pour lire le fi chier précédent.
Appuyez longuement pour revenir en arrière dans le fi chier 
actuellement sélectionné.

Appuyez légèrement pour introduire une pause dans la lecture.

Appuyez légèrement pour reprendre la lecture.

Appuyez légèrement pour reproduire le fi chier suivant.
Appuyez longuement pour avancer dans le fi chier actuellement 
sélectionné.

Pendant la lecture d’un fi chier VBR, la piste précédente pourra ne pas être lue même 
si vous appuyez légèrement sur l’icône [  ].REMARQUE
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RÉPÉTITION D’UN SEGMENT
Cette fonction vous permet d’écouter des parties spécifi ques d’une plage d’une façon 
répétée.Cette option se révèle particulièrement très utile lorsque vous apprenez une 
langue par exemple.

1. Appuyez légèrement sur l’icône [  ] au début du segment que 
vous souhaitez répéter.

Le point de départ est sélectionné et <A  > s’affi che.

2. Appuyez légèrement sur l’icône [  ] pour sélectionner la fi n du 
segment que vous souhaitez répéter.

<A  B> s’affi che et le segment spécifi é est lu de façon répétée.

Annuler la répétition

Appuyez légèrement sur l’icône [  ] pendant la répétition du segment.
La répétition du segment est annulée.

La répétition du segment s’annule automatiquement dans le cas suivant
- Lorsque le début du segment à répéter est défi ni mais que la fi n ne l’est pas avant que la 

plage en cours ne se termine.
- Si le point de fi n est spécifi é sur une durée de lecture inférieure à 3 secondes à compter du 

point de début.

REMARQUE
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CREATION D’UNE LISTE DE LECTURE SUR VOTRE 
LECTEUR MP3
Si vous avez déjà téléchargé des fi chiers sur votre lecteur MP3, vous pouvez créer une 
Liste de lecture « Favoris » sans utiliser EmoDio ni votre ordinateur.

Ajout d’une nouvelle liste de lecture

1. Sélectionnez l’icône  située sur l’écran du menu 
principal.

2. Sélectionnez <Playlists>.

3. Appuyez légèrement sur l’icône [  ].

4. Sélectionnez <Add New Playlist>
(Aj. nouvelle liste lecture).

5. Entrez le nom de votre liste de lecture puis appuyez 
légèrement sur <OK>.

Pour utiliser le clavier, reportez-vous en page 35.

Une nouvelle liste de lecture est ajoutée.

Vous pouvez ajouter 4 listes de lecture supplémentaires à votre lecteur en plus de 
la Playlist1, défi nie par défaut.REMARQUE
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CREATION D’UNE LISTE DE LECTURE SUR VOTRE 
LECTEUR MP3 (Suite)

Modifi cation d’un nom de liste de lecture

1. Sélectionnez l’icône  située sur l’écran du menu 
principal.

2. Sélectionnez <Playlists>.

3. Appuyez légèrement sur l’icône [  ].

4. Sélectionnez <Rename> (Renommer).

5. Appuyez légèrement sur [  ] dans le coin droit de la 
liste de lecture.

6. Modifi ez le nom de votre liste de lecture puis appuyez légèrement sur <OK>.
Pour utiliser le clavier, reportez-vous en page 35.
Le nom de la liste de lecture sera ainsi modifi é.

Suppression d’une liste de lecture
Suivez les étapes 1 à 3 ci-dessus.

4. Sélectionnez <Delete> (Supprimer).

5. Sélectionnez la liste de lecture souhaitée puis appuyez légèrement sur 
<OK>.

Appuyez légèrement sur l’icône [  ] pour sélectionner tous les fi chiers.

La Playlist1 ne peut pas être supprimée.
REMARQUE
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CREATION D’UNE LISTE DE LECTURE SUR VOTRE 
LECTEUR MP3 (Suite)

Ajout d’un fi chier à la liste de lecture

1. Sélectionnez l’icône  située sur l’écran du menu 
principal.

2. Sélectionnez <Music Browser> (Navig. musique).

3. Appuyez légèrement sur l’icône [  ].

4. Sélectionnez <Add to Playlist> (Aj. à liste lect.).

5. Sélectionnez la liste de lecture souhaitée.

6. Sélectionnez un fi chier à ajouter et appuyez légèrement sur <OK> .
Appuyez légèrement sur l’icône [  ] pour sélectionner tous les fi chiers.
Le fi chier sélectionné est ajouté à la liste de lecture.

Lecture d’un fi chier de la liste de lecture

1. Sélectionnez l’icône  située sur l’écran du menu 
principal.

2. Sélectionnez <Playlists>.

3. Sélectionnez la liste de lecture souhaitée.

4. Sélectionnez un fi chier musical à lire.
La lecture du fi chier musical démarre.
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CREATION D’UNE LISTE DE LECTURE SUR VOTRE 
LECTEUR MP3 (Suite)

Suppression d’un fi chier de la liste de lecture

1. Sélectionnez l’icône  située sur l’écran du menu 
principal.

2. Sélectionnez <Playlists>.

3. Sélectionnez la liste de lecture souhaitée.

4. Appuyez légèrement sur l’icône [  ].
Appuyez légèrement sur [  ] pour ajouter un fi chier à la 
liste de lecture actuelle.

5. Sélectionnez un fi chier à supprimer et appuyez légèrement 
sur <OK>.

Appuyez légèrement sur l’icône [  ] pour sélectionner tous 
les fi chiers.

Le fi chier sélectionné est supprimé de la liste de lecture.
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UTILISATION DU MENU MUSIQUE

Avant de démarrer - Appuyez légèrement sur l’icône [  ] située sur l’écran de lecture 
musicale.

Régler la fonction Digital Natural Sound engine (DNSe)
Vous permet de choisir le type de son convenant le mieux à 
chaque genre musical.

1. Sélectionnez <DNSe>.

2. Sélectionnez le DNSe souhaité.

L’option <Auto> sélectionne automatiquement le mode DNSe 
correspondant lorsque les informations relatives au genre 
musical sont indiquées sur l’étiquette ID3 du fi chier musical.
Vous pouvez défi nir les options DNSe pour <myDNSe1> 
et <myDNSe2> via <Settings> (Paramètres)  <Sound> 
(Son)  <myDNSe>.
Qu’est-ce que la fonctionnalité DNSe ?
La technologie Digital Natural Sound Engine (DNSe) est une 
fonction d’optimisation sonore conçue par Samsung pour les lecteurs MP3. Cette 
option offre différents réglages sonores visant à améliorer le type de musique que 
vous écoutez.

REMARQUE
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UTILISATION DU MENU MUSIQUE (Suite)

Régler le mode de lecture
Sélectionnez le mode de lecture parmi les options ci-dessous.

1. Sélectionnez <Play Mode> (Mode lecture).

2. Sélectionnez un mode de lecture de votre choix.

Options du mode de lecture
Normal: Permet de lire une fois tous les fi chiers de la liste 
musicale actuelle dans l’ordre.
Repeat (Répéter): Permet de répéter la lecture de tous les 
fi chiers de la liste musicale actuelle.
Repeat One (Répéter 1X): Permet de répéter la lecture d’un 
fi chier.
Shuffl e (Aléatoire): Permet de répéter la lecture de tous les 
fi chiers de la liste musicale actuelle de manière aléatoire.
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UTILISATION DU MENU MUSIQUE (Suite)

Sélectionner l’écran de lecture musicale
Choisissez une image comme fond d’écran parmi les images disponibles à 
l’affi chage pendant que vous écoutez la musique.

1. Sélectionnez <Music Play Screen> (Ecran Lect mus.).

2. Sélectionnez l’écran de lecture musicale souhaité puis 
appuyez légèrement sur <OK>.

Options de l’écran de lecture musicale
Album Art (Image CD) : L’image de la jaquette du CD s'affi che 
si une image de jaquette fi gure dans les informations de 
l’étiquette ID3 du fi chier musical.
Seules les images de la jaquette du CD de taille inférieure à 2 
Mo sont prises en charge.
Spectrum (Spectre), Passionate (Passion), Sweet (Doux),
Quiet (Calme), Cheerful (Joie): Vous pouvez défi nir plusieurs 
images actives comme images de fond d’écran lorsque vous 
écoutez de la musique.

Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations relatives au 
fi chier telles que le titre, l’artiste, l’album, l’année, le genre et un champ commentaire.

REMARQUE
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UTILISATION DU MENU MUSIQUE (Suite)

Régler le trait horizontal
Vous pouvez régler l’intervalle du trait afi n de parcourir le fi chier musical 
pendant la lecture en faisant glisser le pouce ou les doigts à l’horizontale.

1. Sélectionnez <Horizontal Stroke> (Trait horizontal).

2. Sélectionnez le trait horizontal de votre choix.
Sélectionnez <1 Song> (1 chanson), <10sec Skip> (Saut de 10 s), 
<30sec Skip> (Saut de 30 s) ou <1min Skip> (Saut de 1 min). Ceci 
permet de régler le laps de temps esquivé à chaque fois que vous 
faites glisser le doigt durant l’exécution d’un fi chier musical.

L’intervalle de saut peut différer de l’intervalle actuel, selon le 
fi chier sélectionné.

Ajout de la musique actuellement sélectionnée à la liste de 
lecture
Vous pouvez ajouter le fi chier de musique actuellement sélectionné à la liste de 
lecture souhaitée.

1. Sélectionnez <Add to Playlist> (Aj. à liste lect.).

2. Sélectionnez la liste de lecture souhaitée.
La musique actuellement sélectionnée est ajoutée à la liste de 
lecture.

REMARQUE
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UTILISATION DU MENU MUSIQUE (Suite)

Ajouter à la sonnerie de l’alarme
Vous pouvez ajouter votre fi chier musical favori à la liste des sonneries 
d’alarme afi n de l’écouter lorsque l’alarme se déclenche. Reportez-vous 
à la page 118 pour régler l’alarme.

1. Sélectionnez <Add to Alarm> (Ajouter à alarme).

2. Sélectionnez <Yes> (Oui).
La musique actuellement sélectionnée est ajoutée à la liste 
des sonneries d’alarme.

Il est possible d’ajouter jusqu’à 3 fi chiers musicaux à la sonnerie 
d’alarme.

Régler la vitesse de lecture
Accélérez ou ralentissez votre musique préférée en réglant la vitesse de 
lecture.

1. Sélectionnez <Play Speed> (Vitesse de lecture).

2. Sélectionnez la vitesse de lecture souhaitée puis appuyez 
légèrement sur <OK>.

Vous ne pouvez pas sélectionner l’option <Play Speed> (Vitesse 
de lecture) lorsque le lecteur est connecté au casque d’écoute 
stéréo Bluetooth.

REMARQUE

REMARQUE
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visualisation des images
Vous pouvez agrandir une image ou défi nir l’image de votre choix comme 
image de fond d’écran.

Avant de démarrer - Allumez le lecteur et vérifi ez l’état de la batterie.

VISUALISATION DES IMAGES

1. Sélectionnez l’icône  située sur l’écran du menu principal.

2. Sélectionnez le fi chier image souhaité.
Le dossier <Skin> (Habillage) est un dossier dans lequel sont stockées les 
images défi nies comme images d’arrière-plan. Reportez-vous à la page 78.

<Captured> (Capturé) est un dossier dans lequel sont stockées les images 
capturées en mode vidéo. Reportez-vous à la page 55.

Accéder à l’image précédente/suivante

Appuyez légèrement sur l’icône [  ,  ] située sur l’écran 
d’affi chage de l’image.

Appuyez légèrement sur l’icône [  ,  ] pour obtenir 
une vue en format paysage.

[  ] s’affi chera si les fi chiers image comportent des informations 
erronées sur les vignettes.n.
Certaines images peuvent être affi chées lentement.

REMARQUE
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AGRANDISSEMENT DE L’IMAGE
Vous pouvez zoomer sur une image.

1. Appuyez légèrement sur l’icône [  ] située sur l’écran 
d’affi chage de l’image.

La barre de zoom apparaît.

2. Utilisez la barre de zoom pour agrandir l’image comme vous le 
souhaitez.

Pour annuler l’agrandissement d’une image, appuyez légèrement une 
seule fois sur l’écran tactile puis sur l’icône [  ].

Affi chage de l’image agrandie
Faites glisser l’image agrandie pour accéder à la partie de l’image que vous 
souhaitez agrandir.

VISIONNAGE D’UN DIAPORAMA
Vous pouvez lire les images sous forme de diaporama.

Appuyez légèrement sur l’icône [  ] située sur l’écran d’affi chage 
de l’image.

Vous pouvez lire les images sous forme de diaporama.

Vous pouvez également lancer le diaporama en mode de prévisualisation 
d’image.

Arrêt du diaporama

Appuyez légèrement sur l’écran en mode diaporama.

REMARQUE

REMARQUE
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UTILISATION DU MENU IMAGE
Avant de démarrer - Appuyez légèrement sur l’icône [  ] située sur l’écran 
d’affi chage de l’image.

Réglage de l’effet de diaporama
Vous pouvez régler l’effet de transition afi n de spécifi er les modalités de 
passage d’une image à l’autre lors du visionnage d’un diaporama.

1. Sélectionnez <Slideshow Effect> (Effet diaporama).

2. Sélectionnez l’effet de diaporama souhaité puis appuyez 
légèrement sur <OK>.

Pour faire pivoter une image
Vous pouvez faire pivoter l’image selon vos envies.

1. Sélectionnez <Rotate> (Pivoter).

2. Sélectionnez l’angle de votre choix.



78 _ visualisation des images

UTILISATION DU MENU IMAGE (Suite)
Avant de démarrer - Sélectionnez une image de votre choix puis appuyez légèrement sur 
l’icône [  ] de l’écran d’affi chage de l’image.

Sélectionner une image comme fond d’écran
Vous pouvez défi nir l’image de votre choix comme fond d’écran.

1. Sélectionnez <Assign> (Affecter) <My Skin> (Mon 
habillage).

2. Sélectionnez <Yes> (Oui).
L’image sélectionnée est défi nie comme image de fond d’écran.

Pour sélectionner une image au démarrage
Vous pouvez confi gurer l’affi chage de l’image de votre choix au démarrage de 
l’unité.

1. Sélectionnez <Assign> (Affecter) <Booting Image> (Image de 
démarrage).

2. Sélectionnez <Yes> (Oui).
L’image sélectionnée est réglée comme image de démarrage.
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UTILISATION DU MENU IMAGE (Suite)

Transfert d’une image vers un périphérique Bluetooth
Vous pouvez transférer des fi chiers d’image vers un périphérique externe 
compatible Bluetooth.

1. Sélectionnez <Send> (Envoyer).

2. Sélectionnez le périphérique Bluetooth de votre choix. 
Si vous ne trouverez pas le périphérique Bluetooth souhaité 
dans la liste, appuyez légèrement sur l’icône [ ] pour 
rechercher d’autres périphériques. Reportez-vous à la page 106.

3. Vérifi ez la connexion du périphérique Bluetooth externe.
Le fi chier image sélectionné est alors transféré vers le 
périphérique externe Bluetooth.

Visionnage de l’image sur l’écran du téléviseur
Vous pouvez visionner le fi chier image sur l’écran du téléviseur. Pour plus 
d’informations, reportez-vous en page 38.
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lecture de texte
Qu’il s’agisse d’un roman, d’un nouveau scénario ou d’un article de 
recherche, votre lecteur MP3 vous permet de lire le document tout en 
écoutant de la musique !

Avant de démarrer - Allumez le lecteur et vérifi ez l’état de la batterie.
Réglez la langue du texte dans <Settings> (Paramètres) <Language> (Langue)
<Contents> (Sommaire). Reportez-vous à la page 43.

LECTURE DE TEXTE
1. Sélectionnez l’icône  située sur l’écran du menu principal.

2. Sélectionnez le fi chier texte souhaité.
Le fi chier de texte s’affi che en mode plein écran.

Appuyez légèrement sur l’écran pour affi cher les informations relatives au 
texte et les icônes correspondantes.

Accéder à la page précédente/suivante

Faites glisser horizontalement l’écran d’affi chage de texte.
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UTILISATION D’UN SIGNET

Réglage d'un signet
Défi nissez un signet pour revenir à tout moment à ce point du texte.

1. Appuyez légèrement sur l’icône [  ] à la page 
souhaitée pendant la consultation d’un texte.

2. Sélectionnez <Add Bookmark> (Ajouter signet).
La page actuelle est alors marquée d’un signet à l’aide du 
symbole [ ] qui s’affi che en haut de la page, en mode plein 
écran.

Vous pouvez défi nir un signet pour chaque fi chier texte.

Accès à/Suppression d’un signet

1. Appuyez légèrement sur l’icône [  ] située sur 
l’écran d’affi chage du texte.

2. Sélectionnez <Go to Bookmark> (Accéd. à signet) ou 
<Delete Bookmark> (Supprimer signet).

Vous accédez au signet sélectionné lorsque vous cliquez sur <Go 
to Bookmark> (Accéd. à signet) et vous le supprimez du fi chier 
texte lorsque vous sélectionnez <Delete Bookmark> (Supprimer 
signet).

REMARQUE
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UTILISATION DU MENU TEXTE
Avant de démarrer - Appuyez légèrement sur l’icône [  ] située sur l’écran 
d’affi chage du texte.

Réglage du type de visionneuse de texte
Choisissez le type d’affi chage de texte souhaité.

1. Sélectionnez <Text Viewer Type>
(Type Visionneuse de texte).

2. Sélectionnez le type de visionneuse de texte souhaité et 
appuyez légèrement sur <OK>.

Modifi er la taille de la police
Vous pouvez modifi er la taille de la police utilisée dans le texte.

1. Sélectionnez <Font Size> (Taille police).

2. Sélectionnez la taille de la police souhaitée.
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utilisation de la carte mémoire externe
Ce lecteur dispose d’un logement de mémoire intégrée compatible avec les 
cartes microSDTM et microSDHCTM qui sont essentiellement utilisées pour la 
sauvegarde ou le transfert des fi chiers et des données.

Avant de démarrer - La carte mémoire externe est proposée en option.

INSERTION D’UNE CARTE MÉMOIRE EXTERNE
Disposez la carte mémoire avec la face orientée vers 
le haut et insérez-la complètement jusqu’à ce que vous 
entendiez un déclic signalant que la carte a été installée 
de manière sécurisée.

RETRAIT D’UNE CARTE MÉMOIRE EXTERNE
Exercez une légère pression sur l’extrémité de la carte 
mémoire.

La carte mémoire est éjectée du logement.

Ne retirez pas la carte mémoire lorsque celle-ci est en cours 
d’utilisation. Ceci risque d’endommager la carte, le lecteur ainsi 
que les données qui y sont stockées.
Ce lecteur accepte les cartes microSD ou microSDHC d’une 
capacité allant jusqu’à 8 Go.
(Si vous utilisez une carte mémoire incompatible, vous pourrez endommager celle-ci ou 
vous retrouver dans l’impossibilité de la retirer ; par ailleurs, le lecteur risque de ne pas la 
reconnaître.)
N’insérez pas la carte mémoire à l’envers ou selon une orientation erronée.
Veillez à toujours sauvegarder vos données les plus importantes. Samsung ne sera pas 
tenu responsable de la perte de données occasionnée par l’utilisation d’une carte mémoire 
endommagée.

ATTENTION
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LECTURE D’UN FICHIER CONTENU SUR UNE CARTE 
MÉMOIRE EXTERNE
Vous pouvez lire les images, vidéos, textes et fi chiers musicaux de la carte mémoire 
externe directement sur le lecteur.

1. Sélectionnez l’icône  située sur l’écran du menu principal.

2. Sélectionnez un dossier souhaité pour accéder à la liste de ses 
fi chiers.

3. Sélectionnez le fi chier souhaité.
La lecture du fi chier démarre.

Icône : Fichier vidéo
Icône  : Fichier musical
Icône  : Fichier image
Icône  : Fichier texte

Vous ne pouvez pas lire un fi chier dont le format n’est pas pris en charge par le lecteur.

Certaines options de menu sont désactivées lorsque vous lisez un fi chier sur la carte 
mémoire.

REMARQUE

ATTENTION
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TRANSFERT D’UN FICHIER DE LA CARTE MEMOIRE VERS 
LE LECTEUR
Vous pouvez transférer un fi chier depuis la carte mémoire vers le lecteur.

1. Sélectionnez l’icône  située sur l’écran du menu principal.

2. Sélectionnez un dossier souhaité pour accéder à la liste de ses 
fi chiers.

3. Appuyez légèrement sur l’icône [  ].

4. Sélectionnez <Copy> (Copier).

5. Sélectionnez le fi chier souhaité puis appuyez légèrement sur <OK>.
Appuyez légèrement sur l’icône [  ] pour sélectionner tous les 
fi chiers.

6. Sélectionnez <Yes> (Oui).
Le fi chier sélectionné est transféré vers le lecteur.
Pour annuler le transfert, appuyez légèrement sur <Cancel> (Annul.).

Le fi chier transféré depuis la carte mémoire est sauvegardé via le chemin <File Browser> 
(Dossier Navigateur)  <Shared Data> (Données partagées).REMARQUE
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SUPPRESSION D’UN FICHIER SUR UNE CARTE MÉMOIRE 
EXTERNE
Vous pouvez supprimer un fi chier de la carte mémoire directement sur le lecteur.

1. Sélectionnez l’icône  située sur l’écran du menu principal.

2. Sélectionnez un dossier souhaité pour accéder à la liste de ses 
fi chiers.

3. Appuyez légèrement sur l’icône [  ].

4. Sélectionnez <Delete> (Supprimer).

5. Sélectionnez le fi chier souhaité puis appuyez légèrement sur <OK>.
Appuyez légèrement sur l’icône [  ] pour sélectionner tous les fi chiers.

6. Sélectionnez <Yes> (Oui).
Le fi chier sélectionné est alors supprimé de la carte mémoire.
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TRANSFERT D’UN FICHIER DEPUIS LE LECTEUR VERS LA 
CARTE MEMOIRE
Vous pouvez transférer un fi chier depuis le lecteur vers la carte mémoire.

1. Sélectionnez l’icône  située sur l’écran du menu principal.

2. Sélectionnez un dossier souhaité pour accéder à la liste de ses 
fi chiers.

3. Appuyez légèrement sur l’icône [  ].

4. Sélectionnez <Copy to microSD card> (Copier sur carte SD).

5. Sélectionnez le fi chier souhaité puis appuyez légèrement sur <OK>.
Appuyez légèrement sur l’icône [  ] pour sélectionner tous les 
fi chiers.

6. Sélectionnez <Yes> (Oui).
Le fi chier sélectionné est alors transféré vers la carte mémoire.

Le fi chier transféré depuis le lecteur est enregistré dans le dossier <Shared Data> (Données 
partagées) de la carte mémoire.REMARQUE
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ecouter la radio FM
Vous pouvez écouter ou enregistrer des programmes de radio FM.

Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.

ECOUTER LA RADIO FM

Sélectionnez l’icône  située sur l’écran du menu principal.

La réception de la radio FM est activée.

Pour utiliser la fonction mute (silence)
1. Appuyez légèrement sur l’icône [  ] tout en écoutant la radio FM.

Appuyez légèrement sur l’icône [  ] une nouvelle fois pour reprendre l’écoute.

Connectez toujours vos écouteurs au lecteur pour rechercher ou régler les fréquences et 
écouter la radio FM. 
Les écouteurs sont utilisés comme antenne de réception des ondes FM. 
Dans les zones où la qualité de réception est mauvaise, il se peut que le lecteur ne détecte 
aucune fréquence FM. 

ATTENTION

News
Today Headline
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AFFICHAGE RADIO FM

1 Icône de mode manuel 8 Icône de fréquence précédente
2 Icône de fréquence suivante 9 Icône Muet

3 Témoin de la fréquence en cours 
(MHz) 10

Témoin de la barre de fréquence 
radio

4 Témoin RDS 11 Molette de recherche fréquence
5 Icône de menu 12 Icône de retour en arrière
6 Icône d’enregistrement 13 Icône de fréquence préréglée
7 Icône de mode présélection

Qu’est-ce que le RDS ?
La fonction Système de Radiocommunication de Données (RDS) permet la réception et 
l’affi chage de messages comme la diffusion d’informations. Les informations relatives aux 
programmes (ex. : actualités, sport ou musique) ou aux stations de radiodiffusion s’affi chent 
sur cet écran.
Si la puissance du signal FM est faible, les informations RDS ne s’affi chent pas.
La fonction RDS est disponible uniquement dans les régions d’Europe.
Les représentations à l’écran fi gurent à titre indicatif uniquement. L’écran réel de votre 
appareil peut être différent.

REMARQUE

News
Today Headline
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POUR RECHERCHER DES STATIONS DE RADIO FM
Appuyez longuement sur l’icône [ , ] puis relâchez-la en mode 
Manuel.

La recherche s’arrête à la fréquence la plus proche du point où l’icône est 
relâchée.

OU,

Appuyez légèrement sur l’icône [ , ] pour rechercher les 
fréquences une par une en mode Manuel.

Change de fréquence à chaque nouvelle pression sur l’icône.

OU,

En mode manuel, tournez la molette de recherche de 
fréquence comme pour décrire un cercle.

News
Today Headline
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ENREGISTREMENT DE LA RADIO FM

Enregistrer un programme FM 
Vous pouvez à tout moment enregistrer un programme FM tout en écoutant 
la radio.

Sélectionnez une radiofréquence à enregistrer sur l’écran de 
radio FM et appuyez légèrement sur l’icône [  ].

Le lecteur démarre l’enregistrement.

Pour arrêter un enregistrement

1. Appuyez légèrement sur l’icône [  ] pendant 
l’enregistrement.

Un message apparaît vous demandant si vous souhaitez écouter 
le fi chier que vous venez d’enregistrer.

2. Sélectionnez <Yes> (Oui) ou <No> (Non).
Sélectionner <Yes> (Oui) vous permet de lire le fi chier que vous 
venez d’enregistrer.
Sélectionner <No> (Non) ne vous permet pas de lire le fi chier 
enregistré.

Pour suspendre l’enregistrement, appuyez légèrement sur l’icône [  ].
Le fi chier est enregistré à l’emplacement suivant : <File Browser> (Dossier 
Navigateur)  <Recorded Files> (Fichiers Enregistrés)  <FM Radio> (Radio FM).
La durée maximale d’un fi chier d’enregistrement est de 5 heures.

REMARQUE

News
Today Headline

News
Today Headline
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BASCULEMENT EN MODE PRÉSÉLECTION OU EN MODE 
MANUEL

Pour basculer vers le Mode présélection
Sélectionnez ce mode si vous souhaitez effectuer une recherche de vos 
présélections FM une à la fois.

Appuyez légèrement sur [  ] en mode Manuel.

Si aucune fréquence de présélection n’est défi nie, le lecteur ne 
passe pas en mode Présélection.

Pour basculer vers le Mode manuel
Sélectionnez ce mode si vous souhaitez effectuer une recherche manuelle 
d’une fréquence à la fois sur la bande FM. 

Appuyez légèrement sur [  ] en mode Présélection.

REMARQUE

News
Today Headline

News
Today Headline



ecouter la radio FM _ 93

UTILISATION DU MENU DE LA RADIO FM

Pour enregistrer des stations dans la mémoire de 
présélection
Vous pouvez stocker jusqu’à 30 stations dans la mémoire de votre lecteur MP3 
et y accéder en appuyant légèrement sur une simple icône.
Manuel : sélectionnez uniquement les stations que vous souhaitez enregistrer

1. Sélectionnez une fréquence à prérégler en mode Manual 
(Manuel) puis appuyez légèrement sur l’icône [ ].

2. Sélectionnez <Add to Preset> (Ajouter aux présél.).
La fréquence sélectionnée est ajoutée à la liste de présélections.

Automatique : enregistrez automatiquement toutes les 
stations captées par le lecteur

1. Appuyez légèrement sur l’icône [  ] située sur 
l’écran de la radio FM.

2. Sélectionnez <Auto Preset> (Présélection auto).

3. Sélectionnez <Yes> (Oui).

Pour annuler la présélection automatique
Si vous souhaitez annuler la présélection automatique, 
appuyez légèrement sur l’icône [ ].

La présélection automatique est annulée et seules les fréquences réglées jusque-là 
sont enregistrées.

News
Today Headline
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour écouter une station présélectionnée
Sélectionnez la fréquence préréglée souhaitée en mode 
Présélection.

Vous pouvez écouter la fréquence radio enregistrée.

Pour supprimer une présélection 
Vous pouvez retirer une fréquence préréglée de la liste de présélections.

1. Appuyez légèrement sur l'icône [  ] en mode de 
préréglage.

2. Sélectionnez <Delete from Preset>
(Suppr. du prérégl.).

3. Sélectionnez une fréquence à supprimer et appuyez 
légèrement sur <OK>.

Appuyez légèrement sur l’icône [  ] pour sélectionner 
toutes les fréquences préréglées.

4. Sélectionnez <Yes> (Oui).
La fréquence préréglée sélectionnée est supprimée.

News
Today Headline

News
Today Headline
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Réglage de la région FM
Vous avez la possibilité de modifi er le réglage FM en prévision d’un voyage à 
l’étranger.

1. Appuyez légèrement sur l’icône [ ] située sur 
l’écran de la radio FM.

2. Sélectionnez <FM Region> (Région Radio).

3. Sélectionnez la région FM souhaitée. 
Bande de fréquences par région 

Worldwide 
(Monde)

Recherchez des fréquences FM comprises entre 
87,50 MHz et 108,00 MHz par paliers de 50 kHz.

USA
(États-Unis)

Recherchez des fréquences FM comprises entre 
87,5 MHz et 108,0 MHz pour les lecteurs de 100 
kHz.Korea (Corée)

Japan (Japon)
Recherchez des fréquences FM comprises entre 
76,0 MHz et 108,0 MHz pour les lecteurs de 100 
kHz.

4. Sélectionnez <Yes> (Oui) ou <No> (Non).
Sélectionnez <Yes> (Oui) pour lancer le préréglage automatique de la région 
choisie et sélectionnez <No> (Non) pour ne modifi er que la seule région.

Les fréquences radio que vous avez enregistrées précédemment seront 
supprimées si vous modifi ez le réglage <FM Region> (Région FM) de votre lecteur.
La région FM peut être supprimée ou modifi ée en fonction de la région cible du 
lecteur.

REMARQUE

News
Today Headline
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lecture de jeux fl ash
Votre lecteur mp3 est livré avec des jeux passionnants qui sont préchargés sur 
l’appareil !

LECTURE DE JEUX FLASH

1. Sélectionnez l’icône  située sur l’écran du menu principal

2. Sélectionnez le jeu souhaité.

Des jeux peuvent être ajoutés ou modifi és sans avis préalable.
Pour de plus amples informations, consultez la section de l’aide du jeu concerné.REMARQUE
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LECTURE DE JEUX VIDEO (Suite)

AstroRanger
Il s’agit d’un jeu de battement de mesure, qui vous permet de gagner des points 
en appuyant légèrement sur le bouton en forme d’objet, aussitôt que l’objet visé 
pénètre dans la zone cible, et ce, en rythme avec la musique sélectionnée.

En début de jeu, vous sélectionnez le genre de musique, 
le niveau de diffi culté et le type de bouton souhaités.

Vous gagnez encore plus de points en achetant des 
articles dans la boutique.

Bubble Bang

Vous marquez des points en faisant éclater le plus grand nombre possible de 
bulles dans un délai limité.

Appuyez légèrement sur la bulle ou faites-la glisser pour 
l’éclater.
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LECTURE DE JEUX VIDEO (Suite)

Omok2
Le but de ce jeu de plateau stratégique consiste à placer vos pièces de façon à 
former des rangées continues de cinq pierres à l’horizontale, la verticale et en 
diagonale avant votre adversaire.

Appuyez légèrement sur la zone où vous souhaitez 
placer votre pierre pour qu’elle s’agrandisse.
Appuyez légèrement sur l’emplacement exact où 
vous souhaitez placer votre bloc pendant que la 
zone est agrandie.

Votre bloc se met en position.
Si vous n’avez pas effectué votre tour de jeu dans le temps imparti, la main passe à 
votre adversaire.

Pour quitter le jeu en cours de partie, appuyez en bas à gauche de l’écran tactile.
REMARQUE
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LECTURE DE JEUX VIDEO (Suite)

Jeu d’Omok à 2 en mode Bluetooth

Avant de démarrer - Si le lecteur est relié à un casque stéréo, un téléphone mobile 
ou un périphérique externe Bluetooth, commencez par débrancher la connexion.
Activez le mode Bluetooth du lecteur. Reportez-vous à la page 103.

1. Exécutez <Omok2> sur deux différents 
modèles YP-M1 et sélectionnez le mode 
<Double>.

2. Sélectionnez <Wait> (Patientez) sur un 
lecteur et <Connect> (Connecter) sur 
l’autre.

La mention YP-M1 s’affi che sur l’écran 
<Connect> (Connexion) sélectionné sur YP-M1.

3. Sélectionnez <YP-M1>.
La connexion Bluetooth est établie et la partie à 2 
joueurs commence.
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LECTURE DE JEUX VIDEO (Suite)

PowWow
Ce jeu de tir consiste à marquer des points en tirant sur une cible mouvante.

Appuyez légèrement sur la cible mouvante.

Si vous désirez recharger votre arme, appuyez légèrement sur 
<Reload> (Recharger) sur l’écran.

WiseStar
Il s’agit d’un jeu de puzzle qui vous permet de gagner des zones dans l’espace 
en alignant trois planètes enfi lées à l’horizontale ou la verticale, que vous devez 
faire exploser, l’explosion étant signalée par un changement de la couleur 
d’arrière-plan.

Sélectionnez une planète et replacez-la avec une planète 
environnante.

Les planètes [ ], [ ], [ ] et [ ] sont des éléments 
complémentaires proposés en prime, qui vous permettent de faire 
exploser les planètes environnantes en appuyant légèrement sur 
le bouton [  ] à deux reprises.
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LECTURE DE JEUX VIDEO (Suite)

Sudoku Champ

Il s’agit d’un jeu de plateau de réfl exion qui consiste à attribuer des chiffres de 
1 à 9 non seulement à 9x9 rangées et colonnes mais également à 3x3 petites 
cases.

Sélectionnez une case vide et entrez-y un chiffre de 1 à 9 
une seule fois uniquement, à l’aide des touches numériques 
ci-dessous.

Appuyez légèrement sur <Memo> (Mémo) pour saisir plusieurs 
chiffres dans une case vide.

Appuyez légèrement sur <Menu> (Menu)  <Hint> (Astuces) afi n 
d‘affi cher le chiffre approprié dans la case.

Appuyez légèrement sur <Menu> (Menu)  <Checkup> 
(Vérifi cation) pour vérifi er la case dans laquelle vous avez saisi 
un chiffre incorrect.
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utiliser la fonction bluetooth
La technologie Bluetooth sans fi l permet de connecter sans fi l votre lecteur à 
d’autres périphériques Bluetooth et d’échanger des données avec ces derniers, 
de communiquer en mode mains libres ou d’écouter de la musique avec un 
casque d’écoute stéréo Bluetooth.

 QU'EST-CE QUE LA FONCTION BLUETOOTH ?
Le périphérique Bluetooth peut engendrer du bruit ou créer des dysfonctionnements en 
fonction des conditions d'utilisation.

Des interférences au niveau de la couche physique ; par exemple, si vous tenez le lecteur à la 
main et portez des écouteurs dans les oreilles.
Lorsqu’une partie du corps est en contact avec le système de réception/transmission du lecteur 
ou du périphérique Bluetooth.
Problèmes de transmission/réception provoqués par l’agencement du mur, de l’angle ou du 
bureau.
Interférence électrique provenant d'appareils utilisant la même bande de fréquences 
(ex. : appareils médicaux, fours à micro-ondes et réseaux LAN).

Lorsque vous associez le périphérique Bluetooth au lecteur, veillez à ce que la distance soit 
la plus courte possible.
Plus la distance est grande entre le lecteur et le périphérique Bluetooth, plus la qualité de la 
transmission se dégrade. Si la distance excède la limite autorisée, la communication sera 
coupée.
Il est déconseillé d’utiliser les modes d’affi chage texte ou image pendant que vous 
écoutez de la musique avec les écouteurs stéréo, car les performances du lecteur et les 
communications Bluetooth pourraient être altérées.
Il est possible que la connexion Bluetooth ne fonctionne pas correctement dans les zones 
où la réception est faible (ex. : ascenseur ou sous-sol).
La distance maximale permettant une connexion sans fi l entre le lecteur et le système 
Bluetooth est de 10 m. La connexion s’interrompt automatiquement lorsque cette plage 
est dépassée. Même si la distance est respectée, il est possible que la qualité sonore soit 
détériorée par des obstacles (ex. : murs, portes).
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REMARQUE

REGLAGES BLUETOOTH
Vérifi ez les réglages Bluetooth du lecteur avant d’utiliser la fonction.

Avant de démarrer - Sélectionnez l’icône  située sur l’écran du menu principal

Réglage du mode Bluetooth
Vous devrez activer le mode Bluetooth si vous souhaitez 
connecter le lecteur à un périphérique Bluetooth externe.

Appuyez légèrement sur l’icône [  ].
Lorsque le mode Bluetooth est activé, le témoin bascule sur l’icône 
[ ] marquée du symbole [ ].

Lorsque vous n’utilisez pas le mode Bluetooth, désactivez-le en le réglant via <My Info> 
<Bluetooth> (Bluetooth) sur <Off> (Arrêt). Si l’option <Bluetooth> (Bluetooth) reste réglée sur 
<On> (Marche), la durée de vie de la batterie en sera réduite.

Les produits Samsung permettent d'optimiser les fonctions Bluetooth du lecteur. Si vous 
utilisez les fonctions Bluetooth avec des produits d'autres marques, elles risquent de ne pas 
être pleinement opérationnelles.

Description des icônes Bluetooth
:  Activation du mode Bluetooth          
: Relié à des écouteurs stéréo : Relié à un téléphone mobile

N’utilisez pas la fonction Bluetooth pour des activités considérées comme illégales (piratage, 
dérivation clandestine ou communications non autorisées à des fi ns commerciales). 
Samsung ne saurait être tenu responsable de ces comportements en cas de poursuites.

ATTENTION
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REGLAGES BLUETOOTH (Suite)

Avant de démarrer - Appuyez légèrement sur l’icône [ ] puis sur l’icône [  ].

Désactivation du mode Bluetooth

1. Sélectionnez <My Info>.

2. Appuyez légèrement sur [  ] à côté de l’élément 
Bluetooth.

Le témoin bascule sur l’icône [  ] et le symbole [ ]
disparaît.

Renommer un périphérique Bluetooth
Vous pouvez renommer un périphérique Bluetooth dans la liste des 
périphériques.

1. Sélectionnez <My Info>.

2. Appuyez légèrement sur l’encadré de saisie, en son centre.

3. Renommez le périphérique.
Pour utiliser le clavier, reportez-vous en page 35.
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CONNEXION D’UN PÉRIPHÉRIQUE BLUETOOTH
Si vous souhaitez utiliser la fonction Bluetooth, il faudra d’abord rechercher un 
périphérique Bluetooth et le connecter à votre lecteur.

Avant de démarrer - Commencez par activer le mode Bluetooth du lecteur.
Activez également le mode Bluetooth sur le périphérique souhaité.  (Reportez-vous pour 
cela au manuel d’utilisation de l’appareil.) Si le lecteur est déjà connecté à un périphérique 
Bluetooth, il faudra d’abord le déconnecter.

Réglage de l’option de recherche
Vous pouvez rechercher les périphériques Bluetooth disponibles mais 
uniquement via le service Bluetooth sélectionné.

1. Appuyez légèrement sur l’icône [  ].

2. Sélectionnez <Search Option> (Options de recherche).

3. Sélectionnez le service Bluetooth souhaité puis appuyez 
légèrement sur <OK> .

Le lecteur procède alors à la recherche de périphériques 
disponibles, mais uniquement via le service sélectionné. 
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CONNEXION D’UN PÉRIPHÉRIQUE BLUETOOTH (suite)

Enregistrement d’un périphérique Bluetooth
Recherchez un nouveau périphérique et enregistrez-le à l’aide de votre lecteur. 
Vous n’aurez à l’enregistrer qu’une seule fois.

1. Appuyez légèrement sur l’icône [  ].
Recherchez les périphériques Bluetooth disponibles. 

Vous pouvez utiliser l’icône de page pour faire défi ler la liste de 
périphériques Bluetooth et sélectionner l’élément de votre choix.

2. Faites glisser le périphérique Bluetooth sélectionné vers 
l’icône [  ].

3. Sélectionnez le service Bluetooth souhaité puis appuyez 
légèrement sur <OK>.

Si la fenêtre de saisie du mot de passe apparaît, entrez <0000>.
Si le mot de passe est différent de 0000, reportez-vous au 
manuel d’utilisation du périphérique Bluetooth pour obtenir le 
mot de passe adéquat.

Lorsque vous avez procédé au couplage, vous voyez le témoin 
de connexion s’affi cher entre l’icône du périphérique et l’icône 
[ ].

Aussitôt que vous redémarrez le lecteur ou le périphérique Bluetooth externe, le 
lecteur tente automatiquement de se connecter au périphérique Bluetooth.REMARQUE
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CONNEXION D’UN PÉRIPHÉRIQUE BLUETOOTH (suite)

Connexion d’un périphérique Bluetooth enregistré
Vous pouvez vous connecter directement à un périphérique Bluetooth à 
condition que celui-ci soit enregistré avec le lecteur.

1. Sélectionnez un périphérique Bluetooth enregistré et faites-
le glisser vers l’icône [  ].

2. Sélectionnez le service Bluetooth souhaité puis appuyez 
légèrement sur <OK>.

Vous pouvez utiliser l’icône de page située dans le coin supérieur 
droit pour faire défi ler la liste de périphériques Bluetooth et 
sélectionner l’élément de votre choix.

Lorsque vous avez procédé au couplage, vous voyez le témoin 
de connexion s’affi cher entre l’icône du périphérique et l’icône 
[ ].
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UTILISATION DES ECOUTEURS STEREO BLUETOOTH
Vous pouvez utiliser des écouteurs stéréo Bluetooth pour écouter de la musique avec un 
son stéréo de haute qualité, tout cela sans fi l !

Connexion d’écouteurs stéréo Bluetooth

1. Connectez les écouteurs stéréo Bluetooth de votre choix.
Pour les détails, reportez-vous aux pages 106 ~ 107.

Une fois la connexion établie, [ ] l’icône s’affi che.

2. Lancez la lecture du fi chier de votre choix.
Vous pouvez écouter de la musique à l’aide d’un casque d’écoute stéréo Bluetooth.

La fonction Bluetooth n’est pas prise en charge lorsque vous écoutez la radio FM 
ou jouez à des jeux.  Pour certains fi chiers de vidéo et de musique, la fonction 
Bluetooth peut être inopérante en cours de lecture.

Utilisez uniquement les écouteurs stéréo certifi és Bluetooth.

Ce lecteur n’est pas nécessairement compatible avec tous les casques d’écoute 
stéréo Bluetooth.

Écouteurs stéréo compatibles Bluetooth

Fabricant Modèle
SAMSUNG YA-BS300, YA-BH270B

Sony Ericsson HBH-DS200, HBH-DS970, HBH-DS980

MobiFren GBH-S100

MOTOROLA S9-HD

I.Tech V20

REMARQUE
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UTILISATION D'UN TELEPHONE PORTABLE BLUETOOTH
Une fois connecté à un téléphone portable Bluetooth, vous pouvez passer et recevoir 
des appels téléphoniques sur votre lecteur. Le lecteur fonctionne alors comme un 
appareil mains libres.

Connexion d’un téléphone mobile Bluetooth

Connectez le téléphone mobile Bluetooth de votre choix.
Une fois la connexion établie, l’icône [ ] s’affi che.

Avec certains téléphones portables, les fonctions de recherche de périphérique 
et de communication mobile (passer/recevoir des appels) risquent de ne pas être 
pleinement opérationnelles.
Si vous appuyez sur un bouton du téléphone portable, passez un appel ou mettez 
fi n à un appel alors qu'une connexion Bluetooth est en cours entre le lecteur et le 
téléphone portable, il se peut que le lecteur émette un bruit.
Nous vous recommandons d'utiliser l'anglais pour le nom de périphérique du 
téléphone portable. 

REMARQUE
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UTILISATION D'UN TELEPHONE PORTABLE BLUETOOTH (Suite)

Utilisation du lecteur pour émettre un appel

1. Sur l’écran Bluetooth, sélectionnez <Call by Number>
(Appeler via n°).

2. Saisissez le numéro de téléphone de la personne à 
contacter.

3. Appuyez légèrement sur l’icône [ ].
L’appel vers la personne en question est émis.

Si le téléphone mobile connecté a défi ni des numéros de raccourcis, vous 
pouvez directement appeler sur le lecteur en appuyant longuement sur le 
dernier chiffre du raccourci.

Pour recomposer le dernier numéro utilisé

Sur l’écran Bluetooth, sélectionnez <Redial> (Recomp).
L’appel vers le dernier numéro utilisé est émis.
L’historique des appels récents peut s’affi cher selon le modèle. Sélectionnez le 
dernier numéro de l’historique.

REMARQUE
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UTILISATION D'UN TELEPHONE PORTABLE BLUETOOTH (Suite)

Utilisation de l’historique des appels pour émettre un appel

1. Sur l’écran Bluetooth, sélectionnez <Call History>
(Historique des appels).

2. Sélectionnez le numéro de téléphone souhaité.
L’appel vers la personne en question est émis.

Suppression d’un numéro de téléphone de l’historique 
des appels

1. Sous <Call History> (Historique des appels), appuyez légèrement sur 
l’icône [  ].

2. Sélectionnez un numéro de téléphone à supprimer et appuyez légèrement 
sur <OK>.

3. Sélectionnez <Yes> (Oui).
Le numéro de téléphone sélectionné est supprimé.
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UTILISATION D'UN TELEPHONE PORTABLE BLUETOOTH (Suite)

Répondre au téléphone

1. Lorsque vous recevez un appel, le message <Connect?>
(Se Connecter ?) s’affi che.

2. Sélectionnez <Yes> (Oui).
Vous pouvez alors démarrer une conversation.

Pour basculer vers le téléphone portable lorsque vous 
parlez sur le lecteur (YP-M1)

Tout en parlant sur le lecteur, sélectionnez <Voice to Phone>
(Voix Mode Télé).

Vous pouvez alors continuer la conversation sur le téléphone mobile.

Pour basculer vers le lecteur(YP-M1) lorsque vous 
parlez sur le téléphone portable

Tout en parlant sur le lecteur, sélectionnez <Voice to Hands-free>
(Voix Mode Main Libr).

Vous pouvez alors continuer la conversation sur le kit Mains libres.
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UTILISATION D'UN TELEPHONE PORTABLE BLUETOOTH (Suite)

Réglage du volume

Tout en parlant en mode Mains libres, appuyez sur le bouton [ , ]
pour régler le volume.

Fin de l’appel

Sélectionnez <Disconnect> (Déconnecté) lors de vos 
communications.

La communication est interrompue.
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TRANSFERT DE FICHERS VERS/DEPUIS UN PERIPHERIQUE 
BLUETOOTH
Vous pouvez transférer des fi chiers musicaux, photo ou vidéo depuis des périphériques 
externes compatibles avec la fonction Bluetooth (lecteur MP3, téléphone portable, etc.) 
vers le lecteur et inversement.

Transfert d’un fi chier depuis le lecteur vers le périphérique 
externe

Avant de démarrer - Vérifi ez si le périphérique Bluetooth prend en charge la 
fonction de transfert de fi chier. (reportez-vous au manuel d’utilisation de l’appareil).

1. Connectez le périphérique Bluetooth de votre choix.
Pour les détails, reportez-vous aux pages 106 ~ 107.

Une fois la connexion effectuée, l’écran de transfert des fi chiers 
s’affi che.

2. Sélectionnez un dossier souhaité pour accéder à la liste de 
ses fi chiers.

3. Sélectionnez un fi chier à transférer et appuyez légèrement 
sur <OK>.

Le fi chier sélectionné est transféré vers le périphérique externe.

Les fi chiers DRM (chargeables) ne peuvent être lus sur le lecteur.

Annulation d’un transfert de fi chier
Appuyez légèrement sur <Cancel> (Annul.) pendant le transfert.

Le transfert du fi chier est interrompu.

REMARQUE

Ex. : écran <File 
Transfer> (Transfert 
de fi chiers) du lecteur
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TRANSFERT DE FICHERS VERS/DEPUIS UN PERIPHERIQUE 
BLUETOOTH (Suite)

Quitter le mode de transfert de fi chiers

1. Appuyez longuement sur l’icône [ ] dans la fenêtre de la liste des 
fi chiers.

Chaque fois que vous appuyez légèrement sur l’icône [ ], le lecteur 
revient à l’écran précédent et la fenêtre de fermeture du transfert de fi chiers 
apparaît.

2. Sélectionnez <Yes> (Oui).
Vous avez quitté le mode de transfert de fi chiers.

Transfert d’un fi chier du périphérique externe vers le lecteur
Vous pouvez transférer des fi chiers depuis un périphérique Bluetooth externe 
sur votre lecteur.

Avant de démarrer - Si le lecteur est déjà connecté à un périphérique Bluetooth, il 
faudra d’abord le déconnecter.
Pour jumeler le périphérique externe au lecteur afi n d’effectuer des transferts, 
reportez-vous au manuel d’utilisation de l’appareil.

Lorsque la fenêtre de connexion Bluetooth apparaît, sélectionnez <Yes> (Oui).
Les fi chiers transférés vers le lecteur sont enregistrés via <File Browser> 
(Dossier Navigateur)  dossier <Shared Data> (Données partagées).
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VÉRIFICATION DES PÉRIPHÉRIQUES BLUETOOTH

Vérifi cation du périphérique Bluetooth connecté
Vous pouvez vérifi er le nom, l’adresse et les services disponibles pour le 
périphérique Bluetooth connecté.

1. Sélectionnez le périphérique Bluetooth connecté.

2. Appuyez légèrement sur l’icône [  ].

3. Sélectionnez <Device Info> (Infos périphérique).
Vous voyez s’affi cher les informations relatives au périphérique 
sélectionné.

Les éléments de service disponibles pour le périphérique 
sélectionné sont vérifi és.

Icônes de service

Icône  : Casque stéréo
Icône  : Téléphone mobile
Icône  : Transfert de fi chier
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VÉRIFICATION DES PÉRIPHÉRIQUES BLUETOOTH (Suite)

Déconnexion d’un périphérique Bluetooth

1. Sélectionnez le périphérique Bluetooth connecté.

2. Appuyez légèrement sur l’icône [  ].
Le périphérique Bluetooth sera déconnecté.

Suppression d’un périphérique Bluetooth enregistré
Avant de démarrer - Si le lecteur est déjà connecté à un périphérique Bluetooth 
devant être supprimé, il faudra d’abord déconnecter celui-ci.

1. Sélectionnez un périphérique à supprimer dans la liste de 
périphériques.

2. Appuyez légèrement sur l’icône [  ].
Le périphérique sélectionné est alors supprimé.
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reglage de l’alarme
Ce lecteur dispose d’une alarme dont la désactivation peut être 
programmée à une heure défi nie.

Avant de démarrer - Vous devez tout d’abord régler l’horloge. Reportez-vous à la page 44.

REGLAGE DE L’ALARME
1. Sélectionnez l’icône  située sur l’écran du menu principal
2. Sélectionnez <New Alarm> (Nouvelle alarme).
3. Appuyez plusieurs fois sur le premier élément pour sélectionner la 

fréquence de l’alarme.
4. Appuyez légèrement sur le second élément.
5. Appuyez légèrement sur le haut ou le bas des chiffres dans les 

icônes représentant les heures, les minutes et AM/PM pour régler 
votre alarme puis appuyez légèrement sur <OK>.

6. Appuyez plusieurs fois sur le troisième élément pour 
sélectionner la sonnerie de l’alarme.

7. Appuyez légèrement à plusieurs reprises sur le quatrième élément 
pour sélectionner le type de vibration.

8. Appuyez légèrement à plusieurs reprises sur le cinquième élément 
pour régler l’intervalle de l’alarme.

9. Appuyez légèrement sur <OK>.
10. Sélectionnez <Yes> (Oui).

Le réglage de l’alarme est ajouté à la liste des alarmes.

Vous pouvez enregistrer jusqu’à 7 réglages d’alarme.
REMARQUE
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REGLAGE DE L’ALARME (Suite)

Pour désactiver l’alarme

Le lecteur émet une alarme lorsqu’il atteint l’heure programmée. Pour 
désactiver l’alarme, sélectionnez <Alarm Off> (Alarme désactivée).

Supprimer un réglage d’alarme

1. Appuyez légèrement sur l’icône [  ] située sur 
l’écran de la liste des alarmes.

2. Sélectionnez un réglage d’alarme à supprimer.
Appuyez légèrement sur l’icône [  ] pour supprimer tous 
le réglage.

3. Appuyez légèrement sur <OK>.

4. Sélectionnez <Yes> (Oui).
L’alarme sélectionnée va être supprimée.

Si le lecteur est raccordé à un ordinateur, la fonction d’alarme est désactivée.
ATTENTION
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affi chage des diffusions 
de donnees
Vous pouvez recevoir automatiquement les informations mises à jour 
sans avoir à vous rendre sur les sites d’actualités, les blogs ou les UCC.

Avant de démarrer - Transfert de l’élément de chaîne souhaité vers le lecteur avec <EmoDio>.

AFFICHAGE DES DIFFUSIONS DE DONNEES
Vous pouvez affi cher les éléments de chaîne ajoutés à <Datacasts> (Dif. donn.).

1. Sélectionnez l’icône  située sur l’écran du menu principal.

2. Sélectionnez un titre du canal de votre choix.

Icône : Fichier vidéo
Icône  : Fichier musical
Icône  : Fichier image
Icône  : Fichier texte

3. Sélectionnez le fi chier souhaité.
La lecture du fi chier sélectionné démarre.

Reportez-vous à <Datacasts> (Dif. donn.) dans <EmoDio> pour obtenir des instructions 
détaillées.REMARQUE
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enregistrement vocal
Vous permet d’effectuer un enregistrement vocal.

ENREGISTREMENT VOCAL

Créer un enregistrement vocal

1. Sélectionnez l’icône  située sur l’écran du menu 
principal.

2. Appuyez légèrement sur l’icône [ ].
Le lecteur démarre l’enregistrement.

Ne tenez pas le microphone trop rapproché ou trop éloigné de votre bouche car 
cela pourrait affecter la qualité de l’enregistrement.
L’enregistrement vocal n’est pas optimal lorsque la batterie est trop faible.

ATTENTION
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ENREGISTREMENT VOCAL (Suite)

Arrêter l’enregistrement vocal

1. Appuyez légèrement sur l’icône [ ] pendant 
l’enregistrement.

Un message apparaît vous demandant si vous souhaitez écouter 
le fi chier que vous venez d’enregistrer.

2. Sélectionnez <Yes> (Oui) ou <No> (Non).
Sélectionner <Yes> (Oui) vous permet de lire le fi chier que vous 
venez d’enregistrer.
Sélectionner <No> (Non) ne vous permet pas de lire le fi chier 
enregistré.

Pour suspendre l’enregistrement, appuyez légèrement sur l’icône [  ].
Le fi chier est enregistré à l’emplacement suivant : <File Browser> (Dossier 
Navigateur)  <Recorded Files> (Fichiers Enregistrés)  <Voice> (Voix).
La durée maximale d’un fi chier d’enregistrement est de 5 heures.

REMARQUE
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profi ter des fi chiers fl ash
Vous pouvez profi ter du visionnage de fi chiers fl ash (au format .swf).

VISIONNAGE DE FICHIERS FLASH

1. Sélectionnez l’icône  située sur l’écran du menu principal.

2. Sélectionnez le fi chier fl ash souhaité.
En cours de lecture, appuyez légèrement sur [  ] pour affi cher les 
boutons directionnels [Up, Down, Left, Right] (Haut, Bas, Gauche, Droite) 
en même temps que le bouton <OK>  (Entrée).

Utilisation du chronomètre

1. Sélectionnez l’icône  située sur l’écran du menu 
principal.

2. Sélectionnez un chronomètre au format de fi chier fl ash.

Certains fi chiers swf peuvent ne pas être pris en charge.
Le lecteur peut s’éteindre puis se rallumer en cours de lecture de certains fi chiers swf.REMARQUE
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utilisation de la calculatrice
Le lecteur inclut une calculatrice très pratique.

UTILISATION DE LA CALCULATRICE

1. Sélectionnez l’icône  située sur l’écran du menu principal.

2. Effectuez vos calculs en appuyant sur l’écran tactile.

Appuyez légèrement sur l’icône [  ] pour affi cher les chiffres avec le séparateur des 
milliers (,).REMARQUE
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affi chage du carnet d’adresses
Vous pouvez télécharger le carnet d’adresses en utilisant la fonction 
Bluetooth pour vérifi er le numéro de téléphone et appeler directement 
votre interlocuteur sur le lecteur.

Avant de démarrer - Utilisez tout d’abord la fonction de transfert des fi chiers Bluetooth pour 
télécharger le carnet d’adresses à partir d’un périphérique externe. Pour plus d’informations, 
reportez-vous à <Transfert d’un fi chier du périphérique externe vers le lecteur>. Reportez-
vous à la page 115. Vous devez coupler votre téléphone mobile avec le lecteur avant 
de pouvoir effectuer un appel dans la fenêtre du carnet d’adresses.Pour de plus amples 
informations, reportez-vous à <Utilisation d’un telephone portable bluetooth>. Reportez-vous 
à la page 109.

AFFICHAGE DU CARNET D’ADRESSES
1. Sélectionnez l’icône  située sur l’écran du menu principal.

2. Sélectionnez un nom que vous souhaitez vérifi er dans l’écran du 
carnet d’adresses. 

Les informations concernant l’adresse sélectionnée s’affi chent.

Le carnet d’adresses s’affi che dans l’ordre alphabétique.
Les fi chiers du carnet d’adresses transférés vers le lecteur sont enregistrés dans le dossier 
<File Browser> (Dossier Navigateur)  <Shared Data> (Données partagées).
Seul le format de fi chier vCard est pris en charge par le carnet d’adresses.

REMARQUE
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AFFICHAGE DU CARNET D’ADRESSES (Suite)

Pour effectuer un appel à partir du carnet d’adresses

1. Sélectionnez un nom de contact que vous souhaitez 
appeler dans l’écran du carnet d’adresses. 

2. Sélectionnez le numéro de téléphone souhaité.
Pour effectuer un appel à partir du carnet d’adresses 

Insertion d’une photo dans le carnet d’adresses

1. Dans le carnet d’adresses, sélectionnez un nom de 
contact pour lequel vous souhaitez insérez une photo.

2. Appuyez légèrement sur l’icône [  ].
L’écran de prévisualisation de l’image s’affi che.

3. Sélectionnez la photo souhaitée.
La photo apparaît sous le nom sélectionné dans le carnet 
d’adresses.
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dépannage
Si vous rencontrez un problème avec votre nouveau lecteur MP3, des solutions 
vous sont proposées dans cette liste. Si le problème persiste, contactez le 
service clientèle Samsung le plus proche.

PROBLÈME SOLUTION

L’appareil ne s’allume pas.

• L’appareil ne s’allumera pas si la batterie est entièrement 
déchargée. Rechargez la batterie et remettez l’appareil 
sous tension.

• Appuyez sur le bouton [ ] pendant plus de 10 
secondes pour réinitialiser le lecteur puis redémarrez celui-
ci.

Les boutons ne 
fonctionnent pas.

• Vérifi ez si la fonction Verrouillage est réglée de sorte à 
verrouiller toutes les opérations liées aux boutons.

• Vérifi ez que vous avez appuyé sur le bouton adéquat, puis 
essayez à nouveau.

• Appuyez sur le bouton [ ] pendant plus de 10 
secondes pour réinitialiser le lecteur puis redémarrez celui-ci.

L’écran ne s’allume pas.

• Il se peut que les données affi chées à l’écran ne soient pas 
visibles sous les rayons directs du soleil.

• Si <Display Off & Hold> (Aff désact et verr) est sélectionné 
dans <Settings> (Paramètres) <Display> (Affi cher), 
l’écran s’éteint.

L’alimentation est coupée.
• Votre lecteur MP3 s’éteint automatiquement en l’absence 

de manipulation de bouton ou d’icône pendant 5 minutes 
alors que l’appareil est en mode pause. Allumez le lecteur à 
nouveau.
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PROBLÈME SOLUTION

L’autonomie de la batterie 
peut être différente de 
celle spécifi ée dans le 
manuel.

• L’autonomie de la batterie peut varier en fonction du mode 
son utilisé et du réglage de l’affi chage.

• La durée de vie de la batterie peut être réduite si vous 
exposez le lecteur à des températures basses ou élevées 
pendant des périodes prolongées.

Dysfonctionnement du 
programme EmoDio

• Vérifi ez que votre ordinateur dispose de la confi guration 
requise.

La connexion à 
l’ordinateur est 
interrompue.

• Assurez-vous que le câble USB est branché correctement 
et essayez à nouveau.

• Exécutez la mise à jour de Windows sur votre ordinateur. 
Sélectionnez les mises à jour principales et l’ensemble 
des modifi cations provisoires, puis mettez à jour tous 
les composants. Redémarrez l’ordinateur et rebranchez 
l’appareil.

Le taux de transfert du 
fi chier est trop lent.

• Si plusieurs programmes sont ouverts sur votre ordinateur 
(dont <EmoDio>), le taux de transfert du fi chier sera ralenti.
Quittez les programmes que vous n’utilisez pas et procédez 
à nouveau au transfert.

Le lecteur ne fonctionne 
pas.

• Vérifi ez que le fi chier disponible a bien été enregistré dans 
la mémoire.

• Assurez-vous que le fi chier musical n’est pas endommagé.
• Vérifi ez que la puissance de la batterie est suffi sante.

Les fi chiers ne se 
téléchargent pas.

• Vérifi ez que le câble USB est correctement branché. 
Rebranchez-le au besoin.

• Vérifi ez si vous disposez de Windows Media Player 11 ou 
d’une version supérieure installée sur votre ordinateur. Si 
vous utilisez une ancienne version, téléchargez Windows 
Media Player 11 ou une version supérieure.

• Assurez-vous qu’il reste de l’espace disponible sur la 
mémoire.

• Appuyez sur le bouton [ ] pendant plus de 10 
secondes pour réinitialiser le lecteur puis redémarrez celui-ci.
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PROBLÈME SOLUTION
Des fi chiers ou des 
données manquent.

• Vérifi ez que le câble USB n’a pas été débranché durant 
le transfert du fi chier ou des données. Si tel est le cas, 
les fi chiers/données mais également l’appareil risquent 
d’être endommagés. Samsung ne saurait être tenu pour 
responsable en cas de pertes de données.

Affi chage anormal de la 
durée de lecture.

• Vérifi ez que le fi chier est au format VBR (débit binaire 
variable).

Affi chage anormal du nom 
de fi chier.

• Allez dans <Settings> (Paramètres) <Language>
(Langue) <Contents> (Sommaire) sur l’écran du Menu 
principal et défi nissez la langue qui vous convient.

L’appareil est chaud. • Les phases de chargement peuvent générer de la chaleur. 
Cela n’a aucune incidence sur la durée de vie de l’appareil 
ou sur son fonctionnement.

Un message s’affi che 
pendant le visionnage 
d’une vidéo

• Essayez à nouveau de télécharger le clip vidéo en passant 
par la fonction EmoDio.

La connexion Bluetooth 
ne fonctionne pas

• Vérifi ez que les écouteurs stéréo sont certifi és Bluetooth.
• La connexion Bluetooth peut être désactivée si vous 

éteignez et rallumez le lecteur ou les écouteurs stéréo. 
Dans ce cas, essayez de vous reconnecter.

• Si vous souhaitez parler sur votre téléphone mobile, 
assurez-vous d’avoir interrompu les connexions Bluetooth 
entre le lecteur et les écouteurs stéréo.
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Son Affi cher Langue
(Language) Heure Système

annexe
ARBORESCENCE DES MENUS
Voici une rapide présentation de la façon dont les menus et les fonctions sont organisés 
dans votre nouveau lecteur MP3.

Ecran de sélection du menu

Dossier
Navigateur Alarme Paramètres

Vidéos Musique Images

Flash Player Textes micro SD

Radio FM Jeux Bluetooth

Dif. donn. ENR vocal Carnet d’adr.

Calculatrice
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CARACTÉRISTIQUES DU PRODUIT
Nom du modèle YP-M1
Puissance nominale 5,0 V CC / 1 A

Compatibilité

AUDIO

MPEG1/2/2.5 Couche 3 (8 kbps~ 320 kbps, 8 kHz ~ 48 kHz), 
WMA (8 kbps ~ 320 kbps, 8 kHz ~ 48 kHz),
AAC-LC (16 kbps ~ 256 kbps, 8 kHz ~ 48 kHz),
AAC-Plus (16 kbps ~ 256 kbps, 16 kHz ~ 44,1 kHz),
AAC-Plus amélioré (16 kbps ~ 256 kbps, 326 kHz ~ 44,1 kHz),
Formats PCM linéaire16 bits, FLAC, Ogg(Q0 ~Q10)

VIDÉO

Vidéo Audio

AVI/
SVI

 MPEG4 (720X480 maxi.) Profil simple
 Divx 4/5 (720X480 maxi.)

MP3/AAC/
AAC+/AC3

H.264 (1280X720 maxi.) Profil ligne 
de base AAC

MP4
 MPEG4 (720X480 maxi.) Profil simple
H.264/AVC (1280X720 maxi.) Profil 
ligne de base de niveau 1.3

MP3/AAC/
AAC+

WMV/
ASF

WMV7/8 (640X480) WMV9 Profil 
principal (1280x720) WMA

MOV
 MPEG4 (720X480 maxi.) Profil simple
H.264 (1280X720 maxi.) Profil ligne 
de base

AAC/
AAC+

IMAGE JPEG (ligne de base, progressive), BMP (32 bit max), 
PNG

FLASH SWF (Flash Player 8.0 ou antérieur, ActionScript 2.0 ou 
antérieur)

TEXTE TXT
Sortie des écouteurs 20 mW/Ch. (France 5 mW/Ch.) (basé sur 16 )
Bande de fréquences 
de la sortie 20Hz à 20kHz
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Rapport signal-bruit 91 dB avec fi ltre passe bas 20 kHz (sur la base de 1 KHz, 0 dB)

Nombre de dossiers/
fi chiers pris en charge

Fichier : 5000 maxi.
Dossier : 5000 maxi. (dossier compris)

Durée de lecture (en 
cas d’utilisation des 
écouteurs)

Musique : 30 heures maxi (MP3 128 kbps,  Volume : 15, Mode 
Normal, Affi ch. Désactivé)

Vidéo :  5 heures maxi. (Luminosité 3, Volume : 15, Mode Normal)

Plage de températures 
de fonctionnement -5 ~ 35°C (23 ~ 95°F)

Etui Verre trempé, inoxydable
Poids 91 g
Dimensions
(L x H x P) 54,2 X 98,9 X 9,9 mm

Haut-parleur Puissance de sortie 0,7W

Impédance 8

Plage de fréquences 400 Hz ~ 20 kHz

Radio FM Rapport signal FM 40 dB

Sensibilité FM utile 30 dB

T.H.D. FM 0,5%
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CARACTÉRISTIQUES DU PRODUIT (Suite)

Système sans fi l
ID Bluetooth QD B015438
Type d’émission F1D
Fréquence d’émission 2 402 à 2 480 MHz
Fréquence de réception 2 402 à 2 480 MHz
Nombre de canaux 79 ch
Système de modulation GFSK, 8DPSK
Mode de communication bidirectionnel non simultané
Humidité 0~95%
Version prise en charge 2.1 + EDR
Module BC06-ROM

Le contenu de ce manuel est susceptible d’être modifi é en vue d’être amélioré sans 
notifi cation préalable.
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LICENCE
L’appareil qui se trouve avec ce manuel de l’utilisateur est fourni sous licence sous 
certains droits de propriété intellectuelle de parties tierces. Cette licence est limitée 
à une utilisation privée non commerciale par l’utilisateur fi nal pour les contenus sous 
licence.
Aucun droit n’est concédé pour une utilisation commerciale.
Cette licence ne couvre aucun produit autre que celui-ci et ne peut être étendue à 
un produit ou processus qui n’est pas sous licence selon la norme ISO/IEC 11172-3 
ou ISO/IEC 13818-3 utilisé ou vendu avec ce produit.
La licence couvre uniquement l’utilisation de ce produit pour encoder et/ou décoder 
des fi chiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3. Aucun droit 
n’est cédé sous cette licence pour des caractéristiques ou des fonctions du produit 
qui ne sont pas conformes à la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.

“Protected by U.S. patents of Immersion Corporation.
A list of applicable patents can be found on Immersion’s 
website at www.immersion.com.”
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LES BONS GESTES DE MISE AU REBUT DE CE PRODUIT 
(DÉCHETS D’ÉQUIPEMENTS ÉLECTRIQUES ET ÉLECTRONIQUES)
(Applicable dans les pays de l’Union Européenne et dans d’autres pays européens 
pratiquant le tri sélectif) 
Ce symbole sur le produit, ses accessoires ou sa documentation 
indique que ni le produit, ni ses accessoires électroniques usagés 
(chargeur, casque audio, câble USB, etc.) ne peuvent être jetés 
avec les autres déchets ménagers. La mise au rebut incontrôlée 
des déchets présentant des risques environnementaux et de santé 
publique, veuillez séparer vos produits et accessoires usagés des 
autres déchets. Vous favoriserez ainsi le recyclage de la matière 
qui les compose dans le cadre d’un développement durable. Les 
particuliers sont invités à contacter le magasin leur ayant vendu 
le produit ou à se renseigner auprès des autorités locales pour 
connaître les procédures et les points de collecte de ces produits 
en vue de leur recyclage. Les entreprises et professionnels sont 
invités à contacter leurs fournisseurs et à consulter les conditions 
de leur contrat de vente. Ce produit et ses accessoires ne peuvent être jetés avec les 
autres déchets professionnels et commerciaux.

ELIMINATION DES BATTERIES DE CE PRODUIT
(Applicable aux pays de l’Union européenne et aux autres pays européens dans lesquels des 
systèmes de collecte sélective sont mis en place.)
Le symbole sur la batterie, le manuel ou l’emballage indique que 
les batteries de ce produit ne doivent pas être éliminées en fi n de 
vie avec les autres déchets ménagers. L’indication éventuelle des 
symboles chimiques Hg, Cd ou Pb signifi e que la batterie contient 
des quantités de mercure, de cadmium ou de plomb supérieures aux 
niveaux de référence stipulés dans la directive CE 2006/66. Si les 
batteries ne sont pas correctement éliminées, ces substances peuvent 
porter préjudice à la santé humaine ou à l’environnement. 
Afi n de protéger les ressources naturelles et d’encourager la 
réutilisation du matériel, veillez à séparer les batteries des autres 
types de déchets et à les recycler via votre système local de collecte gratuite des batteries.





Si vous avez des suggestions ou des questions concernant les produits Samsung,
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